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Overview

This section discusses the following topics:
e  When to Use the DeviceMaster NS-Link Device Driver
e Comtrol Drivers Management Console

¢  Supported Operating Systems

e  Products Supported

e (Conventions on Page 6

* Downloading the Latest Software and User Guides on Page 7

When to Use the DeviceMaster NS-Link Device Driver

Install the DeviceMaster NS-Link device driver to use DeviceMaster serial ports
as native COM ports and to set up secure COM ports. If you install the device
driver, you can also configure the ports for socket mode or serial tunneling. See
NS-Link Device Driver Configuration Considerations on Page 27 for detailed
information about the NS-Link device driver.

Comtrol Drivers Management Console

This User Guide discusses how to install and configure Comtrol device drivers
using the Installation Setup Wizard and the Comirol Drivers Management Console
for the NS-Link device driver.

The Comtrol Drivers Management Console is accessible through the Windows
Control Panel using a dedicated shortcut created during the initial device driver
installation process. The Comtrol Drivers Management Console allows you to
browse all installed and supported Comtrol products in one place and apply any
changes quickly.

Note: This User Guide discusses the DeviceMaster, see the RocketPort EXPRESS/
INFINITY, RocketPort and RocketModem (Universal PCI) Series User
Guide for Windows for adapter specific information.

You can refer to Using the Comirol Drivers Management Console on Page 29 for
general information about the Comtrol Drivers Management Console.

Supported Operating Systems

The Comtrol Drivers Management Console supports the following operating
systems:

¢  Windows 7, Windows 8, and Windows 8.1

e  Windows Server 2012, Windows Server 2008, and Windows Server 2003
¢  Windows Vista

e  Windows XP

DeviceMaster Driver User Guide: 2000595 Rev. A Overview - 5



Overview

Products Supported

Conventions

These are the products supported by the Comirol Drivers Management Console:

DeviceMaster LT

DeviceMaster PRO

DeviceMaster RTS

DeviceMaster Serial Hub
DeviceMaster 500

RocketModem IV

RocketPort EXPRESS

RocketPort EXPRESS SMPTE
RocketPort INFINITY

RocketPort Plus Universal PCI
RocketPort Plus/422 Universal PCI
RocketPort Universal PCI
RocketPort Universal PCI SMPTE

In the remainder of this User Guide, the products are referred to accordingly:

Comtrol device unless there is model-specific information

DeviceMaster means the DeviceMaster models listed in the previous
subsection

RocketPort means any RocketPort model

RocketPort EXPRESS/INFINITY means RocketPort EXPRESS, RocketPort
EXPRESS SMPTE, and RocketPort INFINITY

RocketPort and RocketModem (Universal PCI) means RocketModem IV,
RocketPort Universal PCI, RocketPort Plus Universal PCI, RocketPort Plus/
422 Universal PCI, and RocketPort Universal PCI SMPTE

The paths in this Guide to locate DeviceMaster software and documentation point
to the DeviceMaster RTS paths on the ftp site. All supported DeviceMasters
(Products Supported) models use the same software and documentation.

6 - Products Supported
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Overview

Downloading the Latest Software and User Guides

You can use the CD or the following table to locate the latest version of the
software and documentation.

Software Description Document
P
E-é PortVision DX Install on a Windows host to program the IP
3 address and manage your DeviceMaster.
a;;;g A" Refer to PortVision DX Overview on Page 7
=iy _ for more information.
82
(&)
Bootloader is the operating system that runs .
on the DeviceMaster hardware during the =
Bootloader power on phase, which then loads DeviceMaster
o SocketServer. Installation
) Update the Bootloader on your DeviceMaster, |and
= if advised by Technical Support. Configuration
E SocketServer is the name of the TCP/IP Guide
k= socket web page that is integrated in the
R |SocketServer firmware that comes pre-installed on your
& DeviceMaster.
- Note: Make sure you upload the latest
version of SocketServer before
configuring the device driver.
& |Windows 7/8/8.1
.2 |Windows Server
S %\%112(1/(2)328\/%2%3 Install if you want COM ports (native or @
$ |Windows XP secure). -
5 (This Guide)
5 -

PortVision DX Overview

PortVision DX automatically detects Comtrol Ethernet attached products
physically attached to the local network segment so that you can configure the
network address, upload firmware, and manage the following products:

¢ DeviceMaster family, including:
- DeviceMaster LT
- DeviceMaster PRO
- DeviceMaster RTS
- DeviceMaster Serial Hub
- DeviceMaster UP
- DeviceMaster 500
e JO-Link Master
¢ RocketLinx

PortVision DX replaces PortVision Plus. PortVision Plus does not support
operating systems above Windows 7 and SocketServer versions above v9.00 or NS-
Link device driver v10.xx.
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ftp://ftp.comtrol.com/dev_mstr/PortVision_DX/
ftp://ftp.comtrol.com/dev_mstr/PortVision_DX/
ftp://ftp.comtrol.com/dev_mstr/rts/docs/
ftp://ftp.comtrol.com/dev_mstr/rts/docs/
ftp://ftp.comtrol.com/dev_mstr/rts/software/bootloader
ftp://ftp.comtrol.com/dev_mstr/rts/software/bootloader
ftp://ftp.comtrol.com/dev_mstr/rts/software/socketserver
ftp://ftp.comtrol.com/dev_mstr/rts/software/socketserver
ftp://ftp.comtrol.com/dev_mstr/rts/drivers/win7
ftp://ftp.comtrol.com/dev_mstr/rts/drivers/win7
ftp://ftp.comtrol.com/dev_mstr/rts/drivers/win7/sw_doc
ftp://ftp.comtrol.com/dev_mstr/rts/drivers/win7/sw_doc

Overview

PortVision DX may require that you have the latest Microsoft Service pack for
your operating system:

Windows 8/8.1
Windows Server 2012
Windows 7

Windows Server 2008
Windows Vista
Windows Server 2003
Windows XP

In addition to identifying Comtrol Ethernet attached products, you can use
PortVision DX to display any third-party switch and hardware that may be
connected directly to those devices. All non-Comtrol products and unmanaged
RocketLinx devices are treated as non-intelligent devices and have limited feature
support. For example, you cannot configure or update firmware on a third-party
switch.

8 - PortVision DX Overview
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Before Installing the Comtrol Drivers
Management Console

This section provides an overview for the procedures that you may need to perform
before installing the Comtrol Drivers Management Console for the device driver.

This section contains the following discussions:

Initial Installation Quverview on Page 9

Install the Hardware on Page 9

Install PortVision DX on Page 10

Program the IP Address (Network Information) on Page 11
Uploading SocketServer on Page 14

Initial Installation Overview

If you have already performed the following procedures, you can skip to the next
section, NS-Link Device Driver Installation on Page 15.

You may also refer to the DeviceMaster Installation and Configuration Guide,
which provides detailed information about the following procedures:

1.
2.
3.
4

5.

Install the Hardware

Install the hardware (below).
Install PortVision DX (below).
Program the network information using PortVision DX (Page 11).

Check the SocketServer version and determine whether you need to download
an updated version (Page 13).

If necessary, upload the latest version of SocketServer (Page 14).

If you have not done so, install the DeviceMaster:

1.

Connect an Ethernet cable between the DeviceMaster and a host PC NIC or to
the same Ethernet network segment using a standard Ethernet cable. Refer to
Connectivity Requirements on Page 66 for cabling information.

Connect the power supply or cable to the DeviceMaster and apply power.

Check the DeviceMaster LEDs to verify that it is ready. Refer to DeviceMaster
LEDs on Page 68 to determine the LED status.
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Before Installing the Comtrol Drivers Management Console

Install PortVision DX

Use the following procedure to install PortVision DX.

1.
2.

Download PortVision DX from ftp:/ftp.comtrol.com/dev_mstr/portvision_dx.

Execute the PortVision_DX_[version].msi file and follow the Installation

wizard.

Click Launch PortVision DX and Finish in the last installation screen.

Click Scan so that PortVision DX
locates the DeviceMaster.

PortVision DX displays the Comtrol
Ethernet attached products for
which you chose to scan. See the
PortVision DX help system detailed
information about how to use it to
tailor your view.

Go to the next discussion to program

the network information into the
DeviceMaster.

You can save time if you only scan for
DeviceMasters.

Scan Netwark @
Select any number of device types from the list below and dick Scan to start
scanning the network.
[V DeviceMaster 500 / AIR /LT / PRO /RTS f Serial Hub / UP
¥ 10-Link Master
¥ RocketLinx (Managed Only)
Note: If you want to abort the process, dick Cancel.
Cancel

1PV PortVision DX

File Manage View
L A
p~—4

Scan  Refresh All

Tools  Help

=

-

< £

&

Motes

-~ )

=

[F= Eol
> O
Help About Exit

IPORTVIS&%}

R <—Thec
BB v ES9528-XT [11/11]
- B+ EST506(0/1]
+ ESTSI0

¢ ESTSL0-XT

¢ EST528

¢ ESES08

+ ESBSO8F-M

Name : First Floor

¢ ESB309-XT
# ES8510

# ESE510-XT
¢ ES8510-XTE

- S

[below).

See the PortVision DX help system for procedures on organizing
your devices and customizing your view or views in Portvision DX

~

ontents of this folder are displayed in the Device Lisfpane

m

I0-Link Master #1
0 B+ EtherNet/IP System
W o LTI6 #2
Use menu or toolbar to add notesin =~ - - " Modbus Router System
this area. N
—- B+ Modbus/TCP
] - W + PROB Console Port COM Ports [0/1]
. B & RTS2-Port Device Tree Pane
L .. & RTS4 Spare COM Ports
. & SH8 Console Port COM Ports -
» | | Device Name | Model |IP Address MAC Address | 4 Software Version | Status
B EtherNet/IP System UP-1P (5-30V) 192168.11.55  00:C0:4E:21:05:CD EtherNet/IP 4.10 ON-LINE
B+ Modbus/TCP UP-1P(5V) 1921681153  00:CO4E1S04:7A EtherNet/IP 410 ON-LINE
S| |® v Modbus Router System UP-4P (DB9) 19216811.54  00:CO:4E:07:43:84 Modbus Router 5,10 ON-LINE
B SHBConsolePort COMPorts  SH-8P (DB9) 1921681114  00:COAEIC:FRFD NS-Link918 ON-LINE
B « (& PROS Console Port COM Ports ~ PRO-SP (DB9) 19216811.20  00:CO4E:1T:FFFB  NS-Link 9.18 ON-LINE
By LTI622 DM-LT16 1921681161  00:CO4E40:FEFO NS-Link9.23.1 ON-LINE
B RTS4 Spare COM Ports RTS-4P (DB9) 1921681123  00:COMEQT:FRFC SocketServer9.18 QM|
By RTSZPort RTS-2P (2] 1921681152 OR:COAE2FRFS SocketServer918 Remote
~(|@v  ES9528-XT ESO528-XT 19216811105 00:CO:4E:36:00:02 vid (b11.0.4) ON-LINE Device
d i L Device List Pane
For Help, press F1 First Floor 9 [0 [Ready

10 - Install PortVision DX
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Before Installing the Comtrol Drivers Management Console

Program the IP Address (Network Information)

If you have not done so, program the IP address for your network. The following
procedure is to program a single DeviceMaster, if you want to program IP
addresses into multiple DeviceMasters, refer to the PortVision DX help system or
the_DeviceMaster Installation and Configuration Guide.

1. If necessary, start PortVision DX, Start > Programs > Comtrol > PortVision DX >
PortVision DX.

2. Ifthe DeviceMaster that you want to program is not displayed, click Scan.

3. Right-click the DeviceMaster in the Device Tree or Device List pane for which
you want to program network information and click Properties.

Note: Optionally, you can double-click the DeviceMaster and PortVision DX
opens the Properties page.

1B PortVision DX |E=8 B x|

File Manage View Tools Help

e = & 4 e 8 8 < - 0

Scan  Refresh All | Properties  Save load  Upload Reboot Webpage MNotes Help About Exit
B~ [Z=] First Floor [9/9] -
- B + ES9528-XT[11/11]

B~ ESTS06[0/1]
* EST510

IPORTVIS&%;

- EST510-XT
- ES7528
- ES8508
- ES8508F-M
Mame : First Floor - » ES8509-XT i
* ESB510 3
* ESBS10-XT
i+ B~ ESB510-XTE ReteenDeviee
Lo | v 10-Link Ma -
. * EtherNet/IP Syster
. LT16 22 Edit Notes
Use meru o toolar to add notes ¢ Modbus Router S| o —
: * Modbus/TCP
e O Telnet / SSH Session
o s e Advanced » Device Tree Pane
* RTS4 Spare COM
e s Configuration v i
BN Tracker »
P [ MAC Address | & software Version | Status
B EtherNet/IP System B 4E: Etherhet/IP 4.10 ON-LINE

EtherNet/IP 4.10 ON-LINE
Modbus Router 510 ON-LINE

B+  Modbus/TCP Move : 115:04:
B+ Modbus Router System Delete : 43
B+ 5HS Console Port COM Ports : :
B + (& PRO8 Console Port COM Por Help .. 00:C0:4E17:FF:FE  NS-Link 9.18 ON-LINE

NS-Link 9.18 ON-LINE

m

192.108.11.01 00:C0:4E:40:FRF0 NS-Link 9.23.1

B+ RTS4 Spare COM Ports RTS-4P (DB9) 1921681123  00:COAEOT:FRFC SocketServer 918 ON-LINE
presp—————— (| T 2 RTS-2P () 1921681152  00:COME2FRFS SocketServer 018 ON-LINE (TCP)
this area. B ESEs28-XT ESO528-XT 19216811105 00:CO4E3600:02 14 (611.04) ON-LINE

Device Lisf Pane

[ i g

View & Edit the existing properties of the device First Floor 9 [1 [Ready
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Before Installing the Comtrol Drivers Management Console

4. Optionally, enter a friendly device name in the Device Name list box. The
default name is Device and the last three pairs of digits from the MAC address.

RTS_2E - 29:FF:F5 - Properties E@

Tools  Documentation ...

General | Software Settings ‘ Web Interface |

DeviceMaster RTS 2-Port (2E)

DEV/CE-MASTER'

Basic Information

Device Name : |RTS_2E - 23:FF:F5
MAC Address©  [DDCD:AE29FFFS
Serial Number : l—
Device Status : ’Wl
Detection Type : ’m
Network Settings
IFMode: [SwmiclP  ~]
IP Address: | 192 . 168 . 11 52
Subnet Mask : | 255 . 255 . 0 0

Default Gateway : | 192 . 168 . 1 254
Boctloader Timeout : [15
Apply Changes | Unda Changes ‘ w w

5. Optionally, enter the DeviceMaster serial number in the event you need to
contact Comtrol.

Note: The device status from the main screen displays in the Device Status list
box.

6. Select the appropriate Detection Type for this DeviceMaster.

e REMOTE means that IP communications are used instead of MAC
communications. This is generally an indication the DeviceMaster is not on
the local Ethernet segment

¢ LOCAL means that the MAC communications level is used and the
DeviceMaster must be on the local segment for MAC mode to be used. An
IP address is not required but Technical support recommends using an IP
address.

7. Select the appropriate IP Mode for your installation:

¢ Ifyou want to disable IP communications on the DeviceMaster, click
Disable IP.

e To use the DeviceMaster with DHCP, click DHCP IP, and make sure that
you provide the MAC address of the device to the network administrator.
Make sure that the administrator reserves the IP address, subnet mask
and gateway address of the DeviceMaster in the DHCP server.

e To program a static IP address, click Static IP and enter the appropriate
values for your site.

8. Leave the Bootloader Timeout set to the default 15.
9. Click Apply Changes and Close.
10. Go to the next subsection to check the SocketServer version.

12 - Program the IP Address (Network Information) DeviceMaster Driver User Guide: 2000595 Rev. A



Before Installing the Comtrol Drivers Management Console

Check the SocketServer Version

Check the SocketServer version installed on the DeviceMaster against the latest
SocketServer version on the ftp site.

1. If necessary, start PortVision DX: Start > Programs > Comtrol > PortVision DX >
PortVision DX.

Note: The SocketServer version displays for the DeviceMaster under the
Software Version column.

1PV PortVision DX =N =
File Manage View Tools Help
A ~~ y
a A== g > % 4 = e Li {ﬁ b 6 =
Scan  Refresh All Save J - Motes Help  About Exit
= -
- B v ES9528-KT [11/11]
-l v ES7506[0/1]
IPORTVIS MB - [l v ESTS10
(DX )] B v ESTSI0-XT
- [ & EST528
B+ ES8508
" ESBS08F-M
MName : First Fioor - " ESBS09-XT L
B v EsEsl0 3
B« ES8510-XT
@ v ESE510-XTE
1 + 10-Link Master #1
bl * EtherMet/IP System
¢ LT16 #2
Use menu or toobar to add notesin - * Modbus Router System
e * Modbus/TCP
* PROS Console Port COM Ports [0 /1]
* RTS2-Port
* RTS4 Spare COM Ports
= * SHE Console Port COM Ports .
| [ Device Name [ Model [ 1P Address MAC Address | W Software Version | Status
B ESEs28XT ES9528-XT 19216811105 00:CO4E36:00:02 14 (61104 ON-LINE
B RTS2-Port RTS-2P (2E) 1921681152  00:CO4E29:FFF5 (SocketServer 918 ON-LINE (TCP)
Ell|Bmy  LTI6#2 DM-LT16 1921681161  00:CO4EAQFRFD | NS-Link 9.23.1 ON-LINE
B+ SHB Console Port COM Ports  SH-8P (DBS) 1921681114  00:CO:4E:LC:FRFD| NS-Link 9.18 ON-LINE
B+ RTS4 Spare COM Ports RTS-4P (DBY) 1921681123  00:CO4E07:FRFC | NS-Link 918 ON-LINE
B+ {8 PROE Console Port COM Ports ~ PRO-8P (DB3) 1921681120  00:COAEAT:FRFE \NS- : ON-LINE
B+ Modbus Router System UP-4P (DEG) 1921681154  00:CO:4E07:43:84 Modbus Router 5.10 ON-LINE
B EtherNet/IP System UP-1P (5-30V) 1921681155  00:C0:4E:21:05:CD EtherNet/IP 410 ON-LINE
-||®v  ModbusTCP UP-IP(5V) 1921681153  00:CO4ELS:04:7A EtherNet/IP 410 ON-LINE
« 11 »
For Help, press F1 First Floor 9 [0 [Ready

2. Check for the latest SocketServer version.

Note: Although these paths point to the DeviceMaster RTS subdirectory, the
software (applications, firmware, and drivers) and documentation
works on the DeviceMaster LT, DeviceMaster PRO and DeviceMaster
Serial Hub.

FTP subdirectory: ftp://ftp.comtrol.com/dev_mstr/rts/software/socketserver.

FTP directory /dev_mstr/rts/software/socketserver at ftp.comtrol.com

To view this FTP site in File Explorer: press Alt, click View, and then click Open FTP Site in File Explorer.

Up to higher level directory
:00PM
142EM
:10PM

3. If necessary, download SocketServer, and then use the next subsection to
upload SocketServer. If you do not need to upload the latest version of
SocketServer, you are ready to install the device NS-Link device driver using
NS-Link Device Driver Installation on Page 15.

DeviceMaster Driver User Guide: 2000595 Rev. A Check the SocketServer Version - 13
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Uploading SocketServer

The NS-Link device driver loads the current firmware but not until the
DeviceMaster has shown that an old version of the SocketServer (older than 8.00)
or any firmware other than NS-Link Updater is running. The driver does not
upload anything unless it first connects to the default application (SocketServer)

on the DeviceMaster.

Note: If you are familiar with the NS-Link driver, you may want to review

information for existing customers.

Optionally, you can upload the appropriate version of SocketServer after running
the NS-Link device driver Installation Setup Wizard.

Use the following procedure to upload the latest SocketServer version using

PortVision DX.
1. Start PortVision DX, click: Start > Programs > Comtrol > PortVision DX >
PortVision DX.

2. Right-click the DeviceMaster or DeviceMasters of which you want to upload
the latest version of SocketServer and then click Advanced > Upload Firmware.

1PV PortVision DX
File Manage View Tools Help

[E=NEoRE=<=)

Upload a new firmware into the selected device(s)

First Floor

11 2 [Ready

- ~ p - - > —
Scan  Refresh All | Propertiss  Saue Load Upload  Reboot Webpage Help About Exit
- [== First Floor [11 /111 -
W DM-LTI6 PM Lab
£l B+ ES9528-XT [10 510]
IPORTVISH%JiB B v ES7506
@9 / EST510
; ESTS10-XT [1/1]
¢ EST528 Link Tester [7 /12]
+ ES8508 =
Name : First Floar # ESB508F-M
s ESB509-XT
- ES8510
; » ES8510-XT
i@ v ES8510-XTE
......... 1 + IOLM-2-EIP #1
B v Refresh Device
Use menu or toolbar to add notes in -
this area. = Properties
L
BT Edit Notes
b Webpage l
+  Device Nam e [1P Address | MAC Address | Software Version Status
B DM-LT1t = om— bus Router 6.06 ON-LINE
av ES9528-) (b1.1.0.4) ON-LINE
Lv loLhia) Configurstion > Upload Firmware N g e
B Modbus Tracker & Eemnoee s us Router 6.05 ON-LINE
B+ Modbus bus Server 4.04 ON-LINE
B [ Renarme Assign IP to Multiple Devices = T
» v B Move Save Device Diagnestics Data
B+ RIS2-P¢ Delete TOZTESIT, falif FFFE et 9.34 OM-LINE (TCP)
L RTS-1P K 192.168.11.40 00: F SocketServer 9.35 ON-LINE
B RTS4 Sp: Help ... 1921681123 00:CO F NS-Link 9.36 ON-LINE
E 24 192.168.11.14 :COx i
« it »

3. Browse to the location where you downloaded SocketServer, highlight the file,

and click Open.

Click Yes to the Upload Firmware
popup.

Click Yes to the second Upload
Firmware popup.

You can click Refresh to verify that
the upload has been successfully
completed.

If the upload fails, use the PortVision

DX General tab on the Properties
screen to change the Bootloader

Timeout to 45 seconds and then repeat

Steps 2 through 5.

Upload Firmware ... E3

IMPORTANT MOTES :

- This is a very sensitive process and shouldn't be interrupted at all.
- Any access to this application will be blocked during the process.
- It is highly recommended that you save the configuration of your
device(s) before uploading new firmware.
(Refer to PVDX help file for instructions)

Do you want to upload firmware to the selected Device(s) now?

14 - Uploading SocketServer
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This section discusses the following topics:
¢ Overview of the driver installation procedures

e Installation Setup Wizard on Page 15 for initial installation procedures

e  Checking the Device Driver Version on Page 20

e Updating the Driver on Page 21

e Adding a DeviceMaster (Existing Installation) on Page 25

Overview

If there is an NS-Link device driver already installed on your system for the
DeviceMaster, use the following discussions:

e  Updating the Driver on Page 21 if you want to update the existing driver.

e Adding a DeviceMaster (Existing Installation) on Page 25 to add more
DeviceMasters to the existing installation.

If you have performed the following procedures, you can skip to Installation Setup
Wizard to start NS-Link device driver installation.

You can use Before Installing the Comirol Drivers Management Console on Page 9
for procedures for these steps.

1. Install the DeviceMaster.

2. Install PortVision DX.

3. Program the network information (IP address) using PortVision DX.
4

Upload the appropriate version of SocketServer firmware.

Installation Setup Wizard

You can use the following procedure to install the device driver and the Comirol
Drivers Management Console, which is used to configure the driver.

1. Locate the latest driver assembly (.exe) for your product and copy it to a
location that is available to the host.

e Download the latest device driver for the DeviceMaster.

¢ The Software and Documentation CD contains all of the files for
installation, configuration, and troubleshooting. The CD also provides
download links to the Comtrol ftp site to locate the latest files.

Note: Administrative privileges are required to install device drivers on
Windows operating systems newer than Windows Server 2003.

Do not connect RS-422/485 devices until the appropriate port interface
type has been configured in the device driver. The DeviceMaster

& default port setting is RS-232, except for the DeviceMaster Serial Hub.
aution
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2. Execute the NS-Link device driver assembly (DeviceMaster_Windows_x.xx.exe)
and click Next to start the installation.

‘ﬁ DeviceMaster Driver Installation Setup

Welcome to the DeviceMaster
Driver Installation Setup
Wizard

The Setup Wizard will install DeviceMaster Driver Installation
on your computer, Click "Next”™ to continue or "Cancel” to
exit the Setup Wizard.

< Back Next = Cancel

3. Optionally, enter a different location to install the driver files.

1) DeviceMaster Driver Installation Setup =] & ==

Select Installation Folder
This is the folder where DeviceMaster Driver Installation will be installed.

2
v

To install in this folder, didk "Mext”™, To install to a different folder, enter it below or dick
"Browse”,

Folder:

IC:\Program Files {(x86)\Comtrol\DeviceMaster, Browse...

S

i
< Back U[ Nextm [ Cancel

Advanced Installer

4. Click Install.

%) DeviceMaster Driver Installation Setup ]
Ready to Install 9
_—
The Setup Wizard is ready to begin the DeviceMaster Driver Installation installation v
Click "Install” to begin the installation. If you want to review or change any of your
installation settings, dick "Back”. Click "Cancel” to exit the wizard.
Advanced Installer
T
<Back (| Instal QJ [ cancel
e
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5. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

‘ﬁ. DeviceMaster Driver Installation Setup . @

Completing the DeviceMaster
Driver Installation Setup
Wizard

Click the "Finish” button to exit the Setup Wizard.

Launch DeviceMaster Driver Installation

< Back Cancel

If you do not check this box, you can use the shortcut under the Start button at
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard to
install the device driver.

6. Click Next to install the driver.

4 Comtrol Driver Installation wizard ==

Welcome to Comtrol Driver Installation
Wizard

This Wizard will help you Install or Update the
Comtrol driver on this computer, It will even allow
you to Uninstall such drivers from the computer if
you wish to do so.

‘fou may need to restart your computer in order to
complete the process.

Click Mext to continue or Cancel to exit this Wizard.

< Back {l Next; I| Proceed Cancel

e
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7. Click Install and Next.

4 Comtrol Driver Installation wizard ==

Install, Update, or Uninstall driver
Select the operation you wish to perform:

stall

Select this option to install a new device and
update the associated driver(s).

" Update
Select this option to update the driver(s) for the
existing device(s).

" Remove Al

Select this option to remove the existing device(s)
and uninstall all the associated driver(s).

< Back 1 MNext >|: i ) Proceed | Cancel

P

8. Select the DeviceMaster model that you want to install.

4 Comtrol Driver Installation wizard ==

Install a New Comtrel Device

Yfou are about to install 2 new Comtrol Device Driver
on this computer,

As part of this process all previous installations of this
driver will be updated as well.

Please select the DeviceMaster models you want to
install and identify their quantities as well,

DeviceMaster Model
DeviceMaster PRO, 8 Port 1
__| DeviceMaster PRO, 16 Port Mone
evioeMasher Serial Hub, 8 Port 1
|| DeviceMaster Serial Hub, 16 Port  Mone

I P e aRanbne CAR 4 Fart [

Click Mext to continue or Cancel to exit this Wizard.

< Back |® Proceed | Cancel |

s

9. Enter the number of this DeviceMaster model that you want to install and
click Ok.

Device Quantity ? ==

How many units of this DeviceMaster model you would like to install ? |: !j :i vl

10. Repeat Steps 8 and and 9 for each DeviceMaster that you want to install and
click Next
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11. Click Proceed.

% Comtrol Driver Installation wizard

Summary

Driver Package :  DeviceMaster -
Selected Action @ Install
Device(s) : 2 DeviceMaster Unit(s)

IT IS HIGHLY RECOMMENDED TO CLOSE ANY ACTIVE
SERIAL PORT/APPLICATION BEFORE YOU PROCEED.
FAILURE TO DO SO WILL RESULT IN DATA LOSS !

Launch Comtral Drivers Management Console

Click Proceed to continue or Cancel to exit this Wizard.

< Back | Mexk = Iﬁgf\\h Cancel
‘h.‘_‘_‘_lm/

You may see the following popup for each port.

e~

Click here for status.

Installing device driver software * *

You may see this popup for each device.

“|'L Your device is ready to use % *
' Device driver software installed successfully.

12. Verify that all your selections installed and then click the Close button.

' Driver Software Installation

Your device is ready to use

DevicelMaster Port 01 (COM4) q/Raady to use -
DeviceMaster Port 02 (COMS) JREEdy to use T
DeviceMaster Port 03 (COMB) cJRaady to use

DevicelMaster Port 04 (COM3) q/Raady to use =
DeviceMaster Port 05 (COM11) JREEdy to use

DeviceMaster Port 06 (COM12) JREEdy to use

DeviceMaster Port 07 (COM17) cJRaady to use

DevicelMaster Port 08 (COM1E) q/Raady to use

DeviceMaster Port 01 (COM19) JREEdy to use

DeviceMaster Port 02 (COM20) JRaadv to use 2

13. Click the Launch Comtrol Drivers Management Console button.

DeviceMaster Driver User Guide: 2000595 Rev. A
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14. Return to the

Installation wizard and | & Comtrol Driver Installation wizard 5
click Close to exit the
wizard. Summary

15. Go to NS-Link Device === IMPORTANT MESSAGE : o

Please wait a few moments for the background
installation of the Serial Ports to finish. You can then
use Comtrol Drivers Management Console to
configure the device driver you have just installed.

Driver Configuration
on Page 27 to start NS-

Link device driver
configuration.

Finalizing ...
Finished.

<[

The device driver
installation is not
complete until you have
associated the MAC
address to the
DeviceMaster.

Launch Comtrol Drivers Management Console |

|

Press Close to exit this Wizard.

16. After associating the
MAC address, go to <gack |
Configuring Device
Properties on Page 38
to set up device properties (device name and starting COM port number).

17. Go to Configuring COM Port Properties on Page 41 to configure any necessary
COM port characteristics.

After driver installation and configuration, connect the serial devices to the ports.
For information about the DeviceMaster connectors, refer to the DeviceMaster

Installation and Configuration User Guide (Page 7).

Checking the Device Driver Version

Use the appropriate procedure for your operating system to check the Comtrol
device driver version using the Device Manager.

1. In the Comtrol Drivers Management Console, right-click the DeviceMaster
and click Properties.

2. If necessary, click the Driver tab to view the NS-Link device driver version.
You can check this driver version against the_latest driver for your product.
If necessary, you can update the device driver using the next subsection.
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Updating the Driver

Use the following procedure to update the DeviceMaster NS-Link device driver
after initial installation.

If you are unsure what driver version is running, see Checking the Device Driver
Version on Page 20.

1. Locate the latest NS-Link device driver assembly (Page 7) and copy it to a
location that is available to the host.

2. Close any applications that are using serial ports before the NS-Link device
driver installation.

3. Start the update by executing the .exe file.
4. Click Next to start the Installation Setup Wizard.

‘ﬁ DeviceMaster Driver Installation Setup

Welcome to the DeviceMaster
Driver Installation Setup
Wizard

The Setup Wizard will install DeviceMaster Driver Installation
on your computer, Click "Next”™ to continue or "Cancel” to
exit the Setup Wizard.

< Back Next = Cancel

5. Optionally, enter a different location to install the latest NS-Link device driver
files.

‘ﬁ DeviceMaster Driver Installation Setup EI =]

Select Installation Folder

3
_—
This is the folder where DeviceMaster Driver Installation will be installed. v

To install in this folder, didk "Mext”™, To install to a different folder, enter it below or dick
"Browse”,

Folder:

IC:\Program Files {(x86)\Comtrol\DeviceMaster, Browse...

Advanced Installer

i
< Back U[ NextM [ Cancel
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6. Click Install.

‘ﬁ DeviceMaster Driver Installation Setup

Ready to Install
The Setup Wizard is ready to begin the DeviceMaster Driver Installation installation

Nl

Click "Install” to begin the installation. If you want to review or change any of your
installation settings, dick "Back”. Click "Cancel” to exit the wizard.

Advanced Installer

—

ST () .
\h-_shj ncel

7. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

‘ﬁ DeviceMaster Driver Installation Setup

Completing the DeviceMaster
Driver Installation Setup
Wizard

Click the "Finish” button to exit the Setup Wizard.

Launch DeviceMaster Driver Installation

< Back Cancel

If you do not check this box, you can use the shortcut under the Start button at:
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard.
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8. Click Next to update the driver.
izard 1 |

Welcome to Comtrol Driver Installation
Wizard

This Wizard will help you Install or Update the
Comtrol driver on this computer, It will even allow
wou to Uninstall such drivers from the computer if
wou wish to do so,

‘fou may need ko restart your computer in order to
complete the process,

Click Mexk bo continue or Cancel to exit this ‘Wizard,

= Back. | Next; I Procesd Cancel

i

9. Click Update and Next.

mitrol Drives rd 1 |

Install, Update, or Uninstall driver
Select the operation you wish to perform:

7 Instal

Select this option to install a new device and
update the associated driveris),

& |pdate
Select this option to update the driver(s) for the

existing device(s),

7 Remove Al

Select this option to remaove the existing deviceds)
and uninstall all the associated driveris),

< Back I Mexk = | Procesd Cancel

i

10. Click Next to update the driver.

Update Existing Driver(s)

‘fou have chosen to replace your existing driver(s)
with the driver included in this package.

This update will impact all Comtrol hardware, from the
Following product Family, that reside on this PC and
use any version of this driver assembly,

Product Family: DeviceMaster

Click Mexk bo continue or Cancel to exit this ‘Wizard,

< Back | ML = Proceed Cancel
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11. Click Proceed.

4 Comtrol Driver Installation wizard ==
Summary
Driver Package :  DeviceMaster -

Selected Action :  Update
Device(s) : All DeviceMaster Units

IT IS HIGHLY RECOMMENDED TO CLOSE ANY ACTIVE
SERIAL PORT/APPLICATION BEFORE YOU PROCEED.
FAILURE TO DO SO WILL RESULT IN DATA LOSS !

Launch Comtral Drivers Management Console

Click Proceed to continue or Cancel to exit this Wizard.

< Back I Mexk = | Prooeedl\J Cancel |
L

12. Click the Launch Comtrol Drivers Management Console button to configure the
ports or device properties.

13. Return to the Installation wizard and click Close.

Comtrol Driver Installation wizard __ I ll

Summary

#+k IMPORTANT MESSAGE ¢ ;I
Flease wait a few moments for the background

installation of the Serial Ports to finish, You can then

use Comtrol Drivers Management Console to

configure the device driver you have just installed,

Finalizing ...
Finished,

-

Launch Comtrol Drivers Management Console le

|

Press Close to exit this Wizard,

= Back | Iexk = | Procesd I Close |

14. If necessary, go to Configuring COM Port Properties on Page 41 to configure
the NS-Link COM port properties
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Adding a DeviceMaster (Existing Installation)

Caution

Use the following procedure to add aDeviceMaster to an existing DeviceMaster
installation.

1.

2.

Close any applications that are using serial ports before the device driver
installation.

Connect the DeviceMaster to your network and use PortVision DX to program
the IP address.

If you need hardware installation procedures, see Downloading the Latest
Software and User Guides on Page 7).

Do not connect RS-422/485 devices until the appropriate port interface
type has been configured in the device driver. The default port setting
is RS-232.

From the Start button, click Program> Comtrol> DeviceMaster> DeviceMaster
Driver Installation Wizard.

Click Next to start the Comtrol Driver Installation Wizard.

4 Comtrol Driver Installation wizard

Welcome to Comtrol Driver Installation
Wizard

This Wizard will help you Install or Update the
Comtrol driver on this computer, It will even allow
you to Uninstall such drivers from the computer if
you wish to do so.

‘fou may need to restart your computer in order to
complete the process.

Click Mext to continue or Cancel to exit this Wizard.

< Back | MNext = |: I Proceed Cancel

5. Click Install and Next.

4 Comtrol Driver Installation wizard

Install, Update, or Uninstall driver
Select the operation you wish to perform:

& Instal

Select this option to install a new device and
update the assodated driver(s).

" Update
Select this option to update the driver(s) for the
existing device(s).

" Remove Al

Select this option to remove the existing device(s)
and uninstall all the associated driver(s).

< Back | Next>[<| Procesd | Cancel |

6. Click Next and follow the Installation Wizard. Refer to Step 8 on Page 18, for

the remainder of the installation steps if needed.
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If you programmed an IP address into the DeviceMaster for your network using
PortVision DX before installing the NS-Link device driver; first associate the MAC
address to the DeviceMaster and then configure the driver with the IP address
that you programming into the DeviceMaster using PortVision DX.

This section discusses the following topics:

e NS-Link Device Driver Configuration Considerations

e  Using the Comtrol Drivers Management Console on Page 29
e Associating the MAC Address on Page 34

e Using IP Mode and Enabling SSL on Page 36

e Configuring Device Properties on Page 38

o Configuring COM Port Properties on Page 41

e Network Configuration in Comirol Drivers Management Console on Page 46
- Disabling IP Mode on Page 46
- Changing a Static IP Address on Page 47
- Setting Up DHCP on Page 49

e Configuring DeviceMaster Ports as Sockets on Page 50

e FEnabling Secure Data Mode on Page 51

NS-Link Device Driver Configuration Considerations

The following subsections discuss the NS-Link device driver features and topics
that you may want to review before driver configuration.

IP or MAC This is an overview of IP and MAC addressing issues that may affect how you
Addressing Issues configure the DeviceMaster with a brief discussion of advantages of each method.

Note: The default IP address for the DeviceMaster is 192.168.250.250.
The IP addressing scheme (IP mode) has the following advantages:
¢ Uses an IEEE industry standard protocol.

e Allows you to configure systems to use ports on the DeviceMaster that are
outside of the host system’s local Ethernet segment.

Note: This IP address must be a unique reserved IP address. Do not use an
address from a dynamic address pool. If necessary, see the system
administrator for an IP address.

The MAC addressing method (MAC mode) has the following advantages:

¢ Simplifies implementation and ongoing support by eliminating the address
administration issues inherent in network protocols. MAC addresses are
predefined by DeviceMaster and there is no potential for an address conflict at
setup.

e Tt isisolated from foreign LAN segments minimizing potential security issues.
¢ Maximizes throughput of serial data.
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NS-Link Device
Driver Features

Using the Port
Sharing Feature

During initial installation and configuration of the NS-Link device driver, Comtrol
recommends that you associate the MAC address to the DeviceMaster. If you do
not do so, you will not be able to use the following device driver features:

e Access the Advanced tab to review PC network or device network interface
statistics

e Program or change an IP address using through the Network Settings button
¢ Reboot the DeviceMaster from the Com¢rol Drivers Management Console

After associating the MAC address, you can then program the DeviceMaster for IP
or DHCP usage.

You can refer to IP or MAC Addressing Issues on Page 27 for information about
MAC addressing and IP addressing issues.

DeviceMaster ports can be shared by installing the NS-Link device driver on
multiple systems or through socket mode, or combination of both. To do so, install
the NS-Link driver on each system that you want to permit access to the serial
ports. You can share the same port with multiple systems (only one system can
have an open connection to a port at any given time) or you can set up multiple
systems to share specific ports on the device driver..

DeviceMaster
Port 1 Port 2 Port 3 Port 4

COM 5 COM 6 COM 5 COM 6
Configured for System A Configured for System B

Ethernet Hub
System A

Multiple systems can use the same COM port names.
Example:
To configure two ports for System A and two ports for System B,
you could configure the drivers like this:

1. When installing the device driver on System A, click “Not Configured” for the
COM port names for Ports 3 and 4.

2. When installing the device driver on System B, click “Not Configured” for the
OM port names for Ports 1 and 2.

System B

Use port sharing to configure redundant PCs or fail-over protection.

Port System A System B
1 |COM5 Not Configured

2 |COM6 Not Configured

3 |Not Configured |COM5

4 |Not Configured |COM6

Note: Most applications do not release ports, so you may not be able to use port
sharing across multiple systems with the same port. Also, if using port
sharing, make sure that two computers do not try to access the same port at
the same time. Only one computer can control a given port at a given time.
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Using the Comtrol Drivers Management Console

Accessing the
Comtrol Drivers
Management
Console

Displaying All
Installed Devices

This subsection discusses basic Comtrol Drivers Management Console operations,
such as:

e Accessing the Comtrol Drivers Management Console

e Displaying All Installed Devices on Page 29
e Collapsing the View on Page 30

e How to Configure Device Properties on Page 30

e Customizing the Device Name on Page 31

e Customizing the COM Port Name on Page 31
e How to Configure COM Port Properties on Page 32

e  How to Save Changes on Page 33

See Associating the MAC Address on Page 34 to start DeviceMaster configuration
procedures.

Accessing the Comtrol Drivers Management Console can be done using one of the
following methods:

e Windows Control Panel; go to your Control Panel and click on the Comtrol
Drivers Management Console.

e Shortcut; located under Start > Program Files > Comtrol > DeviceMaster >
Comtrol Drivers Management Console.

The Comtrol Drivers Management Console opens and displays all products for
which a device driver was installed.

€ Comtrol Drivers Management Console @

&= DeviceMaster PRO, 8 Port F In order to view f modify the configuration of any Comtrol Device or Serial Port (COM Part), you need
H to first select it from the tree on the left.
- S Port 01 (coM4)

Port 02 (COMS)
Port 03 (COME)
Port 04 (COM3)
Port 05 (COM11)
Port 06 (COM12)
Port 07 (COM17)
: - Port 08 (com1s)
(- N DeviceMaster Serial Hub, 8 Port
Port 01 (COM18)
¥ Port 02 (COM20)
W Port 03 (COM21)

o
5 Part 04 (COM22)

RN

m

Port 05 (COM23)
¥ Port 06 (COM24)
- 5 Port 07 (COM25)
7 Port 08 (com2s)
—J------ RocketPort Infinity/Express
- BB RocketPort EXPRESS, Octa, DBS, PCle
- 5 port01 (comz)
7 Port02 (comas)
w5 Port03 (comzs)
& port04 (com30) i

Comtrel Drivers Management Console version 3,00

Copyright (C) 2011-2014 Comtrel Corparation. Save Configuration | [ Load Configuratian Apoly
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Collapsing the View

view a family or device, click the + to open the selected family.

To collapse the view, click - in the Tree View pane to close the selected family. To

& Comtrol Drivers Management Consale

RocketPort Infinity/Express
RocketPort/RocketModem

In order to view { modify the configuration of any Comtrol Device or Serial Port (COM Port), you need
to first select it from the tree on the left.

Comtrol Drivers Management Console version 3,00
Copyright (C) 2011-2014 Comtrol Corporation.

Save Configuration

Load Configuration Apply

How to Configure
Device Properties
any necessary changes.

This overview discusses changing device properties for a product. Highlight the
device name of the product that you want to configure in the Tree View pane. Make

e Click Apply to save the changes, which saves the changes and leaves the
Comtrol Drivers Management Console open.

¢ Click Ok to save the changes and close the Comtrol Drivers Management

Console.

¢ (Click Cancel to close the Comirol Drivers Management Console without saving

the changes.

If you click a port or device name without saving the changes, the Comtrol Drivers
Management Console will prompt you to Apply, Ignore, or Cancel the changes.

For more information, see Configuring Device Properties on Page 38.

4 Comtrol Drivers Management Console

----- - DeviceMaster

R _._YDevicemaster PRO, 8 Port]
! ESB509-XT=YES (COM102)
P e ¥ Esasos (coMi0g)

5 Porto3(coM12)

¥ ES8510-XTE (COM110)
------ 2 Esasio (comio3)

5 Es7510 (comM109)

A porto7 (COM17)
P e 7 esasoar-MM (COM108)
%8 DeviceMaster Serial Hub, 8 Port

% Es7506 (CoM100)
------ A Port 0z (CoMz0)

5 ES7510-XT (coM107)

¥ Es7528 (COM101)
------ A Portos (CoM25)

5 ES9528-XT (cOM105)

¥ ES8510-XTE (COM106)
------ A Port 08 (COM28)
RocketPort Infinity/Express
RocketPort/RocketModem

General | Advanced

Network Connection Mode
(©)MACMode 00 CO<4E 17FFFB
@ IP Mode
Enable 5L Mode
[C]server Certificate
Client Certificate:

192.188.11.20

Device Settings
Device Name:

UserFriendly Device Name:
Keep Alive Timeout (seconds):
TCP Timeout Multiplier:

Scan Rate (ms):

Verbose Event Log

Netwaork Settings
Reboot Device

DeviceMaster PRO, 8 Part

DeviceMaster PRO, 8 Port

120 (Default: 120)
1 (Default: 1)
10 * (Default: 10)

[7] (Troubleshooting Only)

Comtrol Drivers Management Console version 3,00
Copyright (C) 2011-2014 Comtrol Corporation.

[Save Configuration ] [Laad Canﬁgurauoﬂ] [

oK ][ Cancel ]

Apply
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Customizing the
Device Name

Customizing the
COM Port Name

Change the default Device Name on the Device General tab by changing the name
in the User-Friendly Device Name field and saving the change.

e Comtrol Drivers Management Conscle

-y DeviceMaster
= E DeviceMaster PRO, 8 Port
i e 0__\; ES8509-XT=YES (COM102)
ES8508 (COM108)
Port 03 (COM12)
E£58510-XTE (COM110)
ES8510 (COM103)
£57510 (COM104)
Part 07 (COM17)
ESB8508F-MM (COM105)
iceMaster Serial Hub, 8 Port
ES7506 (COM100)
Port 02 (COM20)
ES7510-XT {COM107)
ES7528 (COM101)
Part 05 (COM25)
E59528-XT (COM105)
E£58510-XTE (COM106)
- 5 port 08 (comz6)
RocketPort Infinity/Express
RocketPort/RocketModem

NS

[}
[=}
i1
=

I

General Advanced

Network Connection Mode
) MAC Mode 00 CO 4E 17FF FB
@ IP Mode 192,168.11.20
Enable 55 Mode
[] Server Certificate
Client Certificate:

Device Settings
Device Mame:

User-Friendly Device Name:
Keep Alive Tmeout (seconds):
TCP Timeout Multiplier:

Scan Rate (ms):

Verbose Event Log

DeviceMaster PRC, 8 Port

PRO -Rocketlinx Console Ports

120

1

10

[] (Troubleshooting Only)

Metwork Settings

(Default: 120)
(Default: 1)

* (Default: 10)

Defaults

Comtrol Drivers Management Console version 3.00
Copyright {C) 2011-2014 Comtrol Corporation.

ISave Configuration ] [Load Configuration ] l

OK

| [ consel | [_oty ] [ e |

Change the default Port Name on the Port Settings General tab by changing the
name in the User-Friendly Port Name field and saving the change.

e Comtrol Drivers Management Conscle

DeviceMaster
+--KeEER DeviceMaster Serial Hub, 8 Port
[=--%gEs PRO - Rocketlinx Consale Ports
i W Es8509-%T (COM102)
ES8508 (COM108)
4l7or o (cov o)
ES8510-XTE (COM110)
A Es8510 (COM103)
7 Es7510 (COM104)
& porto7 (CoM17)
. ESB508F-MM (COM105)
~  RocketPort Infinity/Express
RocketPort/RocketModem

General |

Port Settings

[T Map 2 Stop Bits to 1

Clone

[] Apply These Settings to All Ports

Port Name

COM Name: |COM12

RS Mode:
Override and Lock Baud Rate to:

Transmit Data Timeout on Port Close:

232

MNone

o

[ Wit on Physical Transmission before Completing Write
[ Emulate Modem Hardware RING Signal
[] Allows Parity Conflict (DeviceMaster 1 Port only)

[T Block Plug-H-Play Search for Attached Serial Device

User-Friendly Port Name: ~ Port 03 = Spare Port

[T Renumber All Subsequent Ports Relative to This Port

« (seconds)

Defaults

-

Comtrol Drivers Management Console version 3.00
Copyright {C) 2011-2014 Comtrol Corporation.

[Sa\te Configuration ] [Load Configuration l [

OK

) Comes ) [remnry) [
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How to Configure To change a port’s properties for a product, highlight the port of the product that
COM Port you want to configure in the Tree View pane. Make any necessary changes:
Properties e (Click Apply to save the changes, which saves the changes and leaves the

Comtrol Drivers Management Console open.

¢ (Click Ok to save the changes and close the Comtrol Drivers Management
Console.

¢ (Click Cancel to undo the changes and close the Comtrol Drivers Management
Console.

If you click another port or device name without saving the changes, the Comtrol
Drivers Management Console will prompt you to Apply, Ignore, or Cancel the
changes.

For more information, see Configuring COM Port Properties on Page 41.

After saving the port changes, if desired, you can click Apply These Settings to All
Ports to populate the remaining ports with these NS-Link COM properties.

e Comtrol Drivers Management Console

DeviceMaster General |
&8 DeviceMaster Serial Hub, & Port

o JF ES7506 (COM100) Port Settings

- 3 Port 02 (COM20) RSMode: 232 - e

" § ::;:;;’gé;?:‘l;ﬂn Override and Lock Baud Rate to: ~ Mone - Options
,;;’ Port 05 (COM25) Transmit Data Timeout on Port Close: 0 v (seconds)

- W ES9528XT (COM105)
¥ Es8510-%TE (cOM108) [CIMap 2 top Gits to 1

- F\,i Port 08 (COM25) || wait on Physical Transmission before Completing Write

[=--%&88 PRO - Rockettinx Console Ports [C]Emulate Modem Hardware RING Signal

e F‘y’ [ allow Parity Conflict (DeviceMaster 1 Port only)
7 ES8508 (COM108) [ Block Plug-N-Play Search for Attached Serial Device

- Jf Port 03 = Spare Port (COM12)

o r;ji E58510-XTE (COM110) P

o Jf ES8510 (COM103)

e r;yi ES7510 (COM104) [] Apply These Settings to All Ports

A Porto7 (com17)

e r;ji ES8508F-MM (COM103) Port Name

RocketPort Infinity /Express User-Friendly Port Name: ~ ESB509-XT
- RocketPort/RocketModem

COM Name: _CDM 102 —

[]Renumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 3.00
Copyright (C) 2011-2014 Comtrol Corporation.

Save Conﬁguratun] [Load Cunﬁgurah’un] [ OK ] [ Cancel Apply
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How to Save
Changes

The Comtrol Drivers Management Console indicates that changes have been made
on this screen with a red frame that identifies which device’s General tab you are

editing.

Clicking the Apply button saves the changes on the tab and leaves the Comtrol
Drivers Management Console open for further configuration.

Clicking the Ok button saves the changes on that tab and closes the Comtrol

Drivers Management Console.

Clicking the Cancel button cancels the changes on that tab and closes the
Comtrol Drivers Management Console.

e Comtrol Drivers Management Conscle

- DewiceMaster
E| E DeviceMaster Serial Hub, 8 Port

This frame indicates that changes

have been made but not applied.

[T

- 5 ES7528 (COM101)

Port 05 (COM25)
ES9528-XT (COM105)
ESB510-XTE (COM108)
Port 08 (COM26)
(R PRO - Rockettinx Console Ports
ESB509-XT (COM102)
ESB508 (COM108)

DY

ES8510-XTE (COM110)

ES8510 (COM103)

ES7510 (COM104)

Part 07 (COM17)

e f,__v ESB8508F-MM (COM105)
RocketPort Infinity/Express

- RocketPort/RocketModem

el

Port 03 = Spare Port {COM12)

General | Advanced

Network Connection Mode
() MAC Mode 00 CO 4E ICFFFD

@) [P Mode 192.168.11.14

[T Enable SSL Mode
[ server Certificate
Client Certificate:

Device Settings
Device Name:

UserFriendly Device Name:
Keep Alive Timeout (seconds):
TCP Timeout Multiplier:

Scan Rate (ms):

Verbose Event Log

Metwork Settings
Reboot Device

DeviceMaster Serial Hub, 8 Port

Serial Hub - Rocketiiny Ports

120 (Default: 120)
1 (Default: 1)
10 * (Default: 10)

[] (Troubleshooting Only)

Comtrol Drivers Management Console version 3.00
Copyright {C) 2011-2014 Comtrol Corporation.

Save Configuration ] [Luad Configuration ] [

OK ][ Cancel ][

Apply L\,] [ Help ]
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Associating the MAC Address

Same Network
Segment

The first step to configuring the NS-Link device driver is to associate the MAC
address of the DeviceMaster to the device driver.

You can use the method that is appropriate to your installation:
e Same Network Segment (below)
e Different Physical Segment on Page 35

Although you can and should associate a MAC address on a different physical
segment, the DeviceMaster must be connected to the local network segment or
directly to a NIC on the host system for the NS-Link driver to operate in MAC
Mode.

The DeviceMaster must be connected to the local network segment or directly to a
NIC on the host system to operate in MAC mode and in order for PortVision DX to
detect the MAC address, otherwise you must enter the MAC address manually.

Use the following procedure to associate a MAC address to a DeviceMaster.

1. Ifnecessary, access the Comtrol Drivers Management Console, click Start >
Control Panel > Comtrol Drivers Management Console.

2. Highlight the Device Name of the DeviceMaster that you want to configure.

e Comtrol Drivers Management Console @
e DeviceMaster - General | Advanced |
=3 E DeviceMaster RTS, 2 Port, 2E T
o F‘y‘ Part 01 (COM4) Network Connection Mode
L paaz oy P
E| & PRO - Rocketling Console Ports : 0C0E 2008
i ke Y ES3509T (COM10Z) (2 IP Mode 00 CO 4 2301 38
7 Es8508 (COM108) Enable SSL mc -
- 4 Port 03 = Spare Port (COM12) F cerver oS SOE F £ Reboot Device
7 ESBS10-XTE (COM110) i
F\’f ES8510 (COM103) Client Certificate:
7 Es7510 (cOM104) : :
e F\’; Port 07 (COM17) Device Settings ) i
(y ES8508F-MM (COM105) Device Name:  DeviceMaster RTS, 2 Port, 2E
[=}-AeE: Serial Hub -Rocketing Ports g User-Friendly Device Name:  DeviceMaster RTS, 2 Port, 28
e Y ES7506 (COM100)
e F‘y‘ Part 02 (COM20) Keep Alive Timeout (seconds): 120 (Default: 120)
e W ESTS10T (COM107)
(;"j ES7528 (COM101) TCP Timeout Multiplier: 1 (Default: 1)
ﬁ :retsozg—iio(h::éiims) Scan Rate (ms): 10 ™ (efault: 10)
e ry ES8510-XTE (COM106) Verbose Eventlog || (Troubleshooting Only)
7 Port 08 (comzs)
[z}~ RocketPort Infinity/Express
- BB RocketPort EXPRESS, Octa, DBS, PCle
i S port01(comzz "
Comtrol Drivers Management Console version 3.00
Copyright (C) 2011-2014 Comirol Corporation. save Configuration | [Load Configuration | [ ok | [ cancd | [ Apply | [ hHeb |

3. Select the MAC address from the drop-down list or enter the address from the
MAC address label on the DeviceMaster.

If the appropriate MAC address is not displayed in the drop-down list, then it
can be one of the following reasons:

¢ The DeviceMaster is not on the same network segment

¢ The DeviceMaster not powered on or connected to the network

¢ The DeviceMaster wrong model was selected during the driver installation
¢ Device failure

Note: Ifyou enter the MAC address, make sure that you use the correct format:
00 CO 4E xx xx xx. A space must separate each pair of digits. The MAC
address is located on a label on the DeviceMaster.

34 - Associating the MAC Address
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Different Physical
Segment

If you programmed the IP address using PortVision DX, the IP address
displays in the IP Mode text box.

4. Click Apply to program the driver with the MAC address of the DeviceMaster.

If you do not Apply the changes before leaving this screen, you will be
prompted to Apply, Ignore, or Cancel the changes.

5. Optionally, you can click the Advanced tab and verify that the Device Status
message indicates that the DeviceMaster is active and Ok.

6. You may need to perform some of the following tasks to complete the driver
configuration process.

¢ Configure the DeviceMaster for IP Mode, see Using IP Mode and Enabling
SSL on Page 36

¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.

Use the following procedure to associate a MAC address to a DeviceMaster that is
not on the same physical network segment or not connected directly to the NIC.

1. If necessary, start the Comirol Drivers Management Console.
2. Highlight the Device Name of the DeviceMaster that you want to configure.
3. Enter the MAC address in the MAC Mode text box.

e Comtrol Drivers Management Console

e DeviceMaster - General |
viceMaster RTS, 2 Port, 2E

Advanced

7 portoi(comq)

7 portoz(coms)

[)--R8 PRO - Rocketlinx Cansole Ports

- 5 E58509-XT (COM102)

- S Esa508 (COM108)

- 5 Port03 = Spare Port (COM12)

7 ESas10-TE (COM110)

7 Esasio (comioz)

7 Es7si0 (comiod)

~ S Porto7 (CoM17)

- S E58508F-MM (COM109)

(=488 Serial Hub - Rocketlinx Ports

- S E57506 (COM100)

~ S Portoz (Comz0)

- S E57510-T (CcOM107)

- S E57528 (comM101)

~ 5 Portos (comzs)

- S E58528-XT (COM105)

- 5 E58510-XTE (COM106)

~ 5 Portos (ComM2s)

= RocketPort Infinity/Express

- BB RocketPort EXPRESS, Octa, DBS, PCle

i G portot fcomzn

[

Network Connection Mode
@ MACMode 00 CO 4 29FFF5
() IP Mode
Enable 551 Mode
Server Certificate
Client Certificate:

Device Settings
Device Mame:

User-Friendly Device Name:

TCP Timeout Multiplier:

Yerbose Event Log

Keep Alive Timeout (seconds):

Scan Rate (ms):

Metwork Settings
Reboot Device

DeviceMaster RTS, 2 Port, 2E
DeviceMaster RTS, 2 Port, 22
120 (Default: 120)
1 (Default: 1)

10 ¥ (Default: 10)
[ (Troubleshooting Only)

Defaults

Comtrol Drivers Management Console version 3.00
Copyright (C) 2011-2014 Comirol Corporation.

|save Configuration | [ Load Configuration | [

ok | [ cancel |

Note: When you enter the MAC address, make sure that you use the correct

format: 00 CO 4E xx xx xx. A space must separate each pair of digits.

A MAC address is located on a label on the DeviceMaster or use
PortVision DX to scan the network, which will display the MAC

address.

4. Click Apply to program the driver with the MAC address of the DeviceMaster
or Ok to save the change and close the Comtrol Drivers Management Console.
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If you do not Apply the changes, you will be prompted to Apply, Ignore, or
Cancel the changes.

You may need to perform some of the following tasks to complete the driver
configuration process.

¢ You can now configure the DeviceMaster to operate in IP Mode using the
next subsection.

¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.

Using IP Mode and Enabling SSL

After associating the DeviceMaster with the MAC address you can set the
DeviceMaster to run in IP Mode.

1.
2.
3.

First associate a MAC address (Page 34) to the DeviceMaster.
Highlight the DeviceMaster.

If the DeviceMaster is not on the same network segment, enter the IP address
of the DeviceMaster in the IP Mode text box.

If the DeviceMaster is on the same network segment, the driver populates the
IP Mode text box with the DeviceMaster IP address.

Click the IP Mode radio button.

e Comtrol Drivers Management Console

-y DeviceMaster A General ‘
&= DeviceMaster PRO, 8 Port ]

Advanced

o S Port 01 (COM4)
A3 portoz (CoMS)
A Port03 (COM107)

o 5 Porto4(comi0n)

- % Portos (comM100)

w I Part 06 (COM105)

A Porto7 (COM106)

. 7 Portos (coM18)

- &58] DeviceMaster Serial Hub, & Port

o g Part o1 (CoM13)

wo S Part 02 (COM20)

o Port03 (COM21)

m

Network Connection Mode

(©)MAC Mode 00 CO %€ ICFFFD

Mode
[T] Enable 55L Mode

[ server Certificate
Client Certificate:

192.168.11.14

Device Settings
Device Name:

User-Friendly Device Name:

Network Settings
Reboot Device

DeviceMaster Serial Hub, 8 Port

DeviceMaster Serial Hub, 8 Port

5.

7 portoa(comza)
w44 Port 05 (COM23)
o o Part 06 (COM24)
A3 porto7 (COM25)
7 Port 08 (COM26)
-+ RocketPort Infinity/Express
- BB RocketPort EXPRESS, Octa, DEY, FCle
o I Part ol (comz7)
A3 portoz (COM28)
& Port03 (COM29)
- W Port 04 (COM30)

keep Alive Timeout (seconds): 120 (Default: 120)

TCP Timeout Multiplier: 1 (Default: 1)
ScanRate (ms): 10 * (Default: 10)

Verbose EventLog [ (Troubleshooting Only)

Defaults

Comtrol Drivers Management Consale version 3,00
Copyright (C) 2011-2014 Comtrol Corporation.

lSavaConﬁgurauon] [LoadConﬁguraﬁon] [ QK. ] [ Cancel ] [ Apdy%J [ Help ]

Optionally, click Enable SSL Mode or go to Step 8.

The DeviceMaster must be configured using IP Mode before you can Enable
SSL Mode. If SSL Mode is enabled, TCP connections that carry data to/from
the serial ports are encrypted using SSL or TLS security protocols. This
includes the following:

e TCP connections to the per-serial-port TCP ports (default is 8000, 8001,
8002, ...) are encrypted using SSL/TLS.

36 - Using IP Mode and Enabling SSL
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¢ TCP connections to TCP port 4606 on which the DeviceMaster implements
the Comtrol proprietary serial driver protocol are encrypted using SSL/
TLS.

e Since SSL/TLS can not be used for either UDP data streams or for the
Comtrol proprietary MAC mode Ethernet driver protocol, both UDP and
MAC mode serial data transport features are disabled.

In addition to encrypting the data streams, it is possible to configure the
DeviceMaster so that only authorized client applications can connect using

SSL/TLS.

For this option to function, you must also_Enable Secure Data Mode in the NS-
Link web page.

6. Ifyou are using a server certificate, click the Server Certificate check box and
enter the name in the Server Certificate text box.

This is the RSA identity certificate that the DeviceMaster uses during SSL/
TLS handshaking to identify itself. It is used most frequently by SSL server
code in the DeviceMaster when clients open connections to the DeviceMaster's
secure web server or other secure TCP ports.

If a DeviceMaster serial port configuration is set up to open (as a client) a TCP
connection to another server device, the DeviceMaster also uses this certificate
to identify itself as an SSL client, if requested by the server.

7. Ifyou are using a client certificate, click the drop list and browse to the
appropriate client certificate file.

When configured with a CA certificate, the DeviceMaster requires all SSL/TLS
clients to present an RSA identity certificate that has been signed by the

configured CA certificate. As shipped, the DeviceMaster is not configured with
a CA certificate and all SSL/TLS clients are allowed.

If desired, controlled access to SSL/TLS protected features can be configured
by uploading a client authentication certificate to the DeviceMaster.

When a CA certificate is uploaded, the DeviceMaster only allows SSL/TLS
connections from client applications that provide to the DeviceMaster an
identity certificate that has been signed by the CA certificate that was
uploaded to the DeviceMaster.

This uploaded CA certificate that is used to validate a client's identity is
sometimes referred to as a trusted root certificate, a trusted authority
certificate, or a trusted CA certificate. This CA certificate might be that of a
trusted commercial certificate authority or it may be a privately generated
certificate that an organization creates internally to provide a mechanism to
control access to resources that are protected by the SSL/TLS protocols.

To control access to the DeviceMaster's SSL/TLS protected resources you
should create your own custom CA certificate and then configure authorized
client applications with identity certificates signed by the custom CA
certificate.

8. Click Apply or Ok to save the change and close the Comirol Drivers
Management Console

9. You may need to perform some of the following tasks to complete the
configuration process.

¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

e Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.

¢ Enable Secure Data Mode in the NS-Link web page, see Enabling Secure
Data Mode on Page 51.
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Configuring Device Properties

Use the following procedure to change device settings on a DeviceMaster.

1. Open Comtrol Drivers Management Console (Accessing the Comtrol Drivers
Management Console on Page 29).
2. Highlight the DeviceMaster device name that you want to configure.

e Comtrol Drivers Management Console

=8l

DevicelMaster
= &8 DeviceMaster PRO, 8 Port
7 Es8509XT=YES (COM102)
;/ ES8508 (COM108)
w ' Port03 (COM12)
.Y ESB510-XTE (COM110)
- ES8510 (COM103)
- Y ES7510 (COM104)
e I Port 07 (COM17)

e ESB508F-MM (COM109)
[=B® . _YDeviceMaster Serial Hub, 8 Port
o o ES7506 (COM100)

7 Port 02 (com20)
ES7510-XT (COM107)

»

General | Advanced

Network Connection Mode
() MAC Mode 00 CO 4E ICFFFD
@ 1P Mode
[ Enable S5L Mode
[T server Certificate
Client Certificate:

192.168.11.14

m

Device Settings
Device Mame:

User-Friendly Device Name:

Metwark Settings
Reboot Device

DeviceMaster Serial Hub, 8 Port

DeviceMaster Serial Hub, 8 Port

Port 05 (COM25)
/ ES9528XT (COM105)
o ESB510-XTE (COM108)
7 port 03 (Com26)
= RocketPort Infinity fExpress
- BB RocketPort EXPRESS, Octa, DBS, PCle
- Port01(comz)
- G Port02 (COM28)
w F Port 03 (CoM23)
- ¥ Part 04 {COM30) i

Keep Alive Tmeout (seconds): 120 (Default: 120)

7 Es7528 (Com101)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 > (Default: 10)

Verbose EventLog [| (Troubleshooting Cnly)

Defaults

Comtrol Drivers Management Consale version 3,00
Copyright (C) 2011-2014 Comtrol Corporation.

[Savecunﬁguraﬁnn] [Luad Cnnﬁguraﬁon] [ OK ] [ Cancel ] Apply

3. If desired, change the User-Friendly Device Name.

Optionally, set a different Keep Alive Timeout (Page 39) period. You can set the
amount of time in seconds that this DeviceMaster waits until it closes this
connection and frees all the ports associated with it.

Note: This value may be set to less than 5 seconds, however the DeviceMaster
may not operate at any value less than 5. A recommended value to begin
experimentation with is 10.

5. Optionally, set the TCP Timeout Multiplier (Page 40) value.

Note: This value should not be modified unless the network connection to the
DeviceMaster is very slow, such as, if a satellite uplink connection is
involved. It is recommended that a value over 3 never be used.

6. Optionally, click a different Scan Rate (ms) (Page 40).

7. Optionally, click Verbose Event Log if you want to log additional DeviceMaster
information into the event log.

8. After making your changes, click Apply if you have additional configuration
procedures or click Ok if you have completed configuring your Comtrol devices.

Note: If you do not Apply the changes, you will be prompted to Apply, Ignore, or
Cancel the changes.

The following table provides detailed information about Device General tab options
for the DeviceMaster.
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Device General Tab

Description

Device Name

This is the default name assigned by the driver and it cannot be
changed. You can use the User-Friendly Device Name field to provide
custom device names for your installation.

User-Friendly Device Name

Use this field to enter a more descriptive name. The name that you
assign is not saved until you click Apply or OK.

Keep Alive Timeout (seconds)
Default = 120 seconds

Use this option to set the amount of time in seconds that this
DeviceMaster waits until it closed this connection and frees all the
ports associated with it. The Keep Alive feature works in the
following way.

During normal operation the driver periodically sends a connection
check to the DeviceMaster, and the DeviceMaster then returns a
response. There are two timers: one in the driver, and one in the
DeviceMaster. These timers are reset when a connection check
signal is received. If a connection is broken, that is, a check is not
received, the data is stored in the computer and/or the
DeviceMaster. Depending on the amount of time that has expired
since the connection was lost, the following happens:

e  When the computer loses its connection to the DeviceMaster but
re-establishes it before the time-out period expires, any data
transmitted during this period is queued and sent when the
connection resumes.

¢  When the computer loses its connection to the DeviceMaster
and does not re-establish it before the time-out period expires;
the driver then purges any pending I/O data for ports on that
connection and returns all pending, and future I/O commands,
with the exception of the Close command, to the application with
an error indicating the disconnected status.

This is similar to the processing which occurs when the
computer receives a notification from the DeviceMaster that a
port release request was processed on a port it owns with the
exception that a different status is returned. When the
connection is re-established, the computer will attempt to re-
acquire the ports that were open when the connection was lost.
If the attempt is successful, normal operations resume for the
port. If any port fails to be acquired, then the computer will
continue to fail all further I/O operations, with the exception of a
Close request. When the Close request is received, the port can
then be re-opened.

e Ifthe computer loses its connection and the time period expires,
the DeviceMaster places the port into a state that another
computer can establish a connection, locking out the original
driver when a connection is made. The driver will respond to all
I/0 commands, with the exception of the Close command, with
an error indicating the disconnected status. If the port is still
available when the driver re-establishes a connection, then it
will claim the port and allow I/O to resume.
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Device General Tab

Description

TCP Timeout Multiplier

Default = 1ms

Use the TCP Timeout Multiplier option to modify two timers used in
TCP/IP socket communications.

The first identifies how long the TCP protocol should wait before
timing out an attempt to open a TCP channel. The TCP Timeout

Multiplier default is 1 and the timer defaults to 500 ms when the
TCP/IP address method is used to communicate with a device.

If the TCP Timeout Multiplier is set to 2, the timer would now be
1000 ms, or 1 sec. If the multiplier is 4, the new time-out period
would be 2000 ms, or 2 sec.

The second timer defines how long the driver will wait for a
response from the DeviceMaster when a forced release of a port is
requested. This timer defaults to 8 seconds.

If the TCP Timeout Multiplier is changed to 2, the timer would now
be 16 seconds. If the multiplier is 4, the new time-out period would
be 32 seconds.

Scan Rate (ms)]
Default = 10ms

Typically, you should leave the scan rate set to the default value (10
ms) for most applications. To adjust latency for time-critical
applications, select a longer or shorter interval from the droplist, or
type in the rate (2 to 50). If a value larger than 50 is entered, the
maximum of 50 is implemented.

Note: The faster the scan rate (lower number), the higher the load
on the system processor.

Verbose Event Log
Default = Disabled

Selecting this option causes detailed messages to be sent to the
operating system Event Log. This added information can be useful
when debugging communications and configuration problems

Save Configuration

Click Save Configuration to save the Device Settings for use on
another similar Comtrol device or to archive a copy of your
environments settings.

Load Configuration

Click to Load Configuration to load the Device Settings previously
saved using the Save Configuration feature.

Note: Configuration files must be for the same model with the same
port density. For example, you cannot load a DeviceMaster
PRO configuration file onto a DeviceMaster RTS or a
configuration file for a 32-port DeviceMaster RTS onto a 4-
port DeviceMaster RTS.

Click Ok to save the changes made on this page and close the

Ok Comtrol Drivers Management Console.
Cancel Cancels any changes made on this page.
Click Apply to save the settings on this page. If you do not click
Apply Apply before leaving this page, you will be prompted to Apply or
Cancel the changes.
Defaults Resets this screen to its default values.

40 - Configuring Device Properties
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Configuring COM Port Properties

This section discusses COM port configuration procedures for DeviceMaster NS-
Link ports. If you want to change the starting NS-Link COM port number on the
DeviceMaster, see Configuring Device Properties on Page 38.

If your application does not set COM port properties, use the Device Manager to
access Ports (COM & LPT) to change the port parameters. If the application sets
COM port properties, those settings take precedence over Windows COM port
settings. The exception to this guideline is if you use the Override and Lock Baud
Rate to option.

Use the following procedure to change NS-Link COM port settings on a
DeviceMaster port or ports.

type has been configured in the driver. The driver default port setting
is RS-232.

Open Comtrol Drivers Management Console (Page 29).

i Do not connect RS-422/485 devices until the appropriate port interface

Caution 1

Highlight the appropriate DeviceMaster.
3. Highlight the first port you want to configure.

G Comtrol Drivers Management Consaole @

DeviceMaster General ‘
&= DeviceMaster Serial Hub, 8 Port
~ 5 ES7506 (COM100) Part Settings
F Port 02 (COM20) RS Mode: 232 - T
g; Eg;:;g-go{ﬁiﬂiun Override and Lock Baud Rate to:  None - Optians
- G port0s (coMas) Transmit Data Timeout on Port Close: 0 = (seconds)
- S ESS528-KT (COM105)
5 Es8510%TE (CoM108) [CMap 2 Stop Bits to 1
- ;j Part 08 (COM28) []wait on Physical Transmission before Completing Write
=}--%&88 PRO -Rodketlinx Console Ports [CJEmulate Modem Hardware RING Signal
- f,_lf [T Allow Parity Confiict (DeviceMaster 1 Port only)
(;_;_i ES8508 (COM108) [ Block Plug-M-Play Search for Attached Serial Device
« 5 Port03 = Spare Port (COM12)
- ES85104TE (COM110) ——
- 5 ES8510 (COM103)
e M ES7510 (COM104) [] Apply These Settings to All Ports
- S Port07 (Com17)
e 0__\; ESB8508F-MM (COM105) Part Name
RocketPort Infinity/Express

UserFriendly Port Name: ~ ES8509-XT

COM Mame: _CDMJ.UZ bd

[~ Renumber All Subsequent Ports Relative to This Port

- RocketPort/RocketModem

Comtrol Drivers Management Console version 3.00
Copyright {C) 2011-2014 Comtrol Corporation.

Save Cunﬁgurah’un] [Luad Cunﬁguraﬁon] [ 0K ] [ Cancel Apply
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4. Select the appropriate communications mode.

Note: The DeviceMaster Serial Hub only supports RS-232. If you select RS-
422 or RS-485 on the DeviceMaster LT, you may want to configure
Terminator Resistor options. If so, click the Terminator Resistor Options
button.

e Comtrol Drivers Management Conscle

Eh--y- DeviceMaster General |
[=)--%@Ems DeviceMaster LT, 16 Port
e M Port 01 (COM11) Port Settings
j e e RS Mode: "~ [ ——
- ar . 232 Options
" M Port 04 (COM13) Override and Lock Baud Rate to: m
(,é_f_i Port 05 (COM21) Transmit Data Timeout on Port Close: ﬁ: Eﬂ"’e) Siave)
s Port 06 (COM24) ire, Slave
e g; Port 07 (COM25) [] Map 2 Stop Bits to 1 455 (4-wire, Master)
(y Port 08 (COM26) [ wait on Physical Transmission before Completing Write: ; - -
e S Port0s (com3s) [] Emulate Modem Hardware RING Signal This option is only available
e M Port 10 (COM36) [] Allow Parity Conflict (DeviceMaster 1Portonly) ORI the DeviceMaster LT.
(;_;_i Port 11 (COM38) [ Block Plug-H-Play Search for Attached Serial Device
3 oo
- 5 Port 13 (COM40)
' port 14 (coma1) iz
- S Port 15 (Com42) [”] Apply These Settings to All Ports
- 5 Port 16 (COM43)
& DeviceMaster RTS, 4 Port Port Name
A8 DeviceMaster Serial Hub, 8 Port User-Friendly Port Name:  Port01
- %gEm PRO - Rocketlinx Console Ports
RocketPort Infinity/Express COM Name:
- RocketPort/RocketModem
[T Renumber All Subsequent Ports Relative to This Port

Comtrel Drivers Management Console version 2,11

Copyright (C) 2011-2013 Comtrol Corporation. [Save Configuration ] [Lnad Configuration ] [ OK ] [ Cancel ] Apply

Make the appropriate selections to reflect your configuration.

Terminator Resistor Options

NOTE

‘fou may use one or both of these two options to improve the integrity of the signal
on a long distance high-speed R5-422 or R5-485 network.

Using these options you can place a 120 O termination resistor between each of
the transmit differential pair or receive differential pair on every portin R5-422 or
RS-485 mode.

If enabled, termination resistors will be placed between the signals shown below:
*RS5-422 mode:

- Between TxD+ and TxD-
-Between RxD+ and RxD-

*R5-485 mode (4-wire):
-Between TxD+ and TxD-
- Between RxD+ and RxD-

*R5-485 mode (2-wire):

-Between TxD+ and TxD-
T DeviceMaster LT, Only
- It does NOT apply.

|:| Tx Terminator Resistor

|:| Rx Terminator Resistor

[ Defaults ][ OK ][ Cancel ]

5. Enable the features that you require for your environment.

Note: You can use the help system or refer to the following table for
information about each option.
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6. Optionally, click the RTS Toggle Options button:

¢ Ifyour communications application does not toggle FTS when transmitting
in RS-485 mode.

* Ifyouare using an  ror e ——
RTS Toggle Options ) 21xl
external RS-232 to Ly
RS-485 converter’ MOTE: ‘You may need to use one aor more of the settings below in any of the Fallowing
which is attached to cases:
a pOI‘t that 18 -- If your communications application doesn't taggle RTS when transmitting in
configured for RS- RS-465 mods,
232 . -- If ywou are using an external RS-232 to R5-485 converter attached to a port
Cl k th configured in R3-232 mode,
a. 1C e
appropriate options
fo%'pyogr p [~ Owverride and Lock to R5-485 Toggle Made
environment. [~ RS-485 Toggle RTS Low
b. Click OK to save
the Changes and Defaulks | QK I Cancel |

return to the port
General tab.

7. If desired, click the Clone check box to set all of the ports on this Comtrol
device to these characteristics.

8. Optionally, change the User-Friendly Port Name.

9. Ifdesired, select a different COM Name (NS-Link COM port number). The
drop-down list displays (in use) next to COM port numbers that are already in
use in this system. Do not duplicate COM port numbers as this will cause the
ports to not function.

10. Click Apply to save these changes.

Note: If you selected RS-422 mode, make sure that there is not a device
attached to the port and click OKk.

11. Highlight the next port that you want to configure and perform Steps 4
through 10.
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The following table provides information about the options on the port General tab.

Port Settings

Default = RS-232

General Tab Description
Use this drop-down list to select the communications mode for the serial
device that you will be connecting to this port.
e RS-232
e RS-422
e RS-485 Mode provides these choices, depending on the model.

Note: The DeviceMaster LT and DeviceMaster RTS 2-port models
support RS-485 4-wire, Slave or Master. The DeviceMaster PRO
and other DeviceMaster RTS models only support RS-485 2-wire.

- RS-485 2-wire (half-duplex) supports transmit and receive data. When

RS Mode data is transmitted, the Transmit Enable signal is activated, and the

transmit receive device switches from receive to transmit
automatically.

- RS-485 4-wire Master (full-duplex master) supports transmit and
receive data, which means both signals are always active. The
DeviceMaster is enabled by the Transmit Enable signal. This mode is
the same as RS-422.

- RS-485 4-wire Slave (full-duplex slave) supports transmit and receive
data. When data is transmitted, the Transmit Enable signal is
activated, the transmit device goes active and starts sending data.
When the data is not being sent, the transmit device is inactive. The
receive device is always active. If you click RS-485, you may need to
change settings in the RTS Toggle Options screen.

Note: The DeviceMaster Serial Hub default value is RS-422, the default
value is RS-232 for other DeviceMasters.

Override and Lock
Baud Rate to

Default = None

This option allows you to lock selected ports.

You can select a value from the drop-down list or enter an appropriate value
from the following standard baud rates: 300, 600, 1200, 1800, 2400, 3600,
4800, 7200, 9600, 14400, 19200, 38400, 57600, 115200, 230400, 460800, or
921600.

After locking a baud rate, no matter what baud rate is selected in a host
application, the actual rate used is the rate specified here.

RTS Toggle Options

This button opens the RTS Toggle Options popup, which provides the
following features:

¢ Override and Lock to RS-485 Toggle Mode

Use the Override and Lock to RTS Toggle Mode option to lock the port in
RTS (Request to Send) toggle mode, then set the mode (low or high) as
desired for RS-485 mode.

* RS-485 Toggle RTS Low

Use the RTS Toggle RTS Low option to toggle the RTS output signal low
during data transmission, which may be needed for relay devices for RS-
485.

If the option box is not checked, RTS is toggled high (asserted) during
data transmission for RS-485 mode.

e  Defaults

Clicking the Defaults button returns all the values in the RTS Toggle
Options popup to their default state:

- Override and Lock to RTS Toggle Mode = Disabled

- RTS Toggle RTS Low = Disabled
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Port Settings
General Tab

Description

Terminator Resistor
Options

(DeviceMaster LT,
Only)

Optionally, click the Terminator Resistor button to enable termination
resistors.

To ensure the best signal integrity on a long distance high-speed RS-422 or
RS-485 network, sometimes it is required to place a 120{) termination
resistor between each of the transmit differential pair or receive differential
pair.

Signal reflection is reduced and a reliable communication is ensured by
placing the 120{) termination resistor. The DeviceMaster LT provides
software controllable 120() termination resistor for each differential pair on
every port in RS-422 and R$S-485 mode. Use the Termination Resistor
Options popup to place 120() termination resistors between the signals
shown below:

e RS-422 Mode

- Between TxD+ and TxD- (Pins 5 and 7)
- Between RxD+ and RxD- (Pins 4 and 2)

e RS-485 Mode — Between TxD/RxD+ and TxD/RxD- (Pins 5 and 7)

Transmit Data Timeout
Port Close

Default = 0

This option allows you to select the length of time to wait for data to clear the
transmit buffer after a host application has closed the port. This is typically
used with serial devices such as printers, to give the data sufficient time to
flush through the system.

Map 2 Stop Bits to 1
Default = Disabled

If your application is hard-coded to use two stop bits and you receive framing
errors, click this check box to map 2 stop bits to 1 bit.

Leave this check box blank to enable stop bits to pass through unchanged.

Wait on Physical
Transmission before
Completing Write

Default = Disabled

This option forces all write packets to wait until the transmit data has
physically completed the transmission before returning completion to the
host application.

The default mode (check box not clicked) is to buffer the data in the transmit
hardware buffer, and return completion as soon as the packet is in the buffer.

Emulate Modem
Hardware RING Signal

Default = Disabled

Click this check box to emulate the ring indicator signal.

If this box is checked and the port receives a RING signal (or an alternate
code, as defined in the AT command set for the modem), it sends an RI signal
to the communications application.

Block PnP search for
attached serial device

Default = Disabled

This option disables plug and play from searching for a device attached to the
serial port.

For example, data received during device discovery on a device is assumed to
be a mouse to plug and play.

Allow Parity Conflict
(DeviceMaster 1-Port
only)

Default = Disabled

Use this option to allow a parity conflict on a DeviceMaster 1-port. It may be
necessary to use this option after you have determined that the cabling is
correct and you are able to transmit data but not receive proper data.

Clone: Apply all the
settings to all ports

Default = Disabled

If this check box is not clicked, changes apply to the selected port only.
If this check box is clicked, changes apply to all ports on this board.

User-Friendly Port
Name

You can enter a custom COM port name to identify this DeviceMaster in the
Comtrol Drivers Management Console.
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%’;ﬁgf;tﬁ%s Description
The COM Name drop list allows you to renumber this COM port. If you see a
COM port number followed by (in use), this means that Plug and Play sees
those COM port numbers in use by another device.

COM Name If you renumber this COM port and click the Renumber All Subsequent Ports
Relative to The Port option, the device driver will renumber all of the ports on
the DeviceMaster, starting with the number you select in this drop list.

If you rename the port to a COM name used by another port, a dialog appears
indicating that the port is already in use.

Renumber All .

Subsequent Ports Use the Renumber All Subsequent Ports Relative to This Port option to renumber

Relative to the Port all subsequent ports on the DeviceMaster relative to the port displayed in the

. COM name drop list.
Default = Disabled
Defaults

. Click the Defaults button to return to the driver default values.
Default = Disabled

Network Configuration in Comtrol Drivers Management Console

Disabling IP Mode

Comtrol recommends using PortVision DX to configure network settings.

Optionally, you can use the Comtrol Drivers Management Console to:

Disable IP communications.

Change the IP address (if the MAC address has been associated to the
DeviceMaster), see Changing a Static IP Address on Page 47.

Configure the DeviceMaster for use with DHCP, see Setting Up DHCP on Page
49.

Use this procedure if you want to disable IP communications.

1.

If necessary, access the Comtrol Drivers Management Console.

Note: The DeviceMaster must be operational in MAC mode on a local network
segment or connected directly to the PC (Associating the MAC Address

on Page 34).

Make sure that the MAC Mode radio button has been selected.
Highlight the Device Name of the 21|
DeviceMaster that you want to
configure.

. | Disable 1P
Click the Network Settings button. R
Click the Modify button.  Static 1P
Click Disable IP.

1P Address: I 192,168.11.20
Subnet Mask: I 755,255,0,0
Gateway: I 192.168.11.1

Modif‘: | Applychangesl Close I
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Changing a Static IP
Address

You can use the Disable IP option if you are not using IP addressing (DHCP or
static) and operating the DeviceMaster in MAC mode.

& Disable I
" DHCP IR
" Skatic IP

1P Address: I 192,168.11.20
Subnet Mask; I 255,255.0,0
Gateway: I 192.168.11.1

Iodify: | Apply Chan%\s I Close |

7. Click the Apply Changes button.
8. Click Yes to the Warning popup.

After the DeviceMaster is rebooted,
the following occurs:

¢ In PortVision DX, the IP address
displays as 0.0.0.0. W |

¢ In the Comtrol Drivers
Management Console:

- The IP address in the Network Settings popup displays 255.255.255.255.

- If the DeviceMaster had been set to IP Mode, the previously programmed
IP address will appear in the IP Mode text box. You can delete the IP
address from the IP Mode text box and click Apply to clear the IP address
from the text box.

arnine ]
Y¥ou have selected to disable DHCP and static IP access to the DeviceMaster!

Do you wank ko conkinue?

9. Click Close to return to the Comtrol Drivers Management Console.
After disabling IP communications, you may need to do the following:

¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.

Typically, PortVision DX is used to program the IP address into the DeviceMaster
during initial configuration. After associating the DeviceMaster with the MAC
address you can change the IP address using the Comtrol Drivers Management
Console.

1. Before programming an IP address it is critical that the DeviceMaster be
operational (the PWR or Status LED is lit) when configured for the MAC
address (Associating the MAC Address on Page 34).

Note: If the DeviceMaster is NOT operational, do NOT attempt to program or
use an IP address with the DeviceMaster.

DeviceMaster Driver User Guide: 2000595 Rev. A Changing a Static IP Address - 47



NS-Link Device Driver Configuration

2.

o O W

10.
11.

12.

Highlight the Device Name of the

: 2
DeviceMaster that you want to e 2l
configure.

| Disahle
Click the Network Settings button. - o

DHER IR
Click the Modify button. ¢ static 1P
Click Static IP. .
IP Address: |192.168.11.20

Enter static IP address information in S
the fields below. |

Gateway: |192.168.11.1

a. IP Address: Enter a valid IP address
for your network. The IP Address
field is the IP address programmed
into the DeviceMaster after
applying the changes and rebooting
the DeviceMaster. See your network
administrator for a valid IP address.

b. Mask: The subnet mask is a 32-bit value (255.x.x.x) that enables IP
packets to distinguish the network ID and host ID portions of the IP
address that filters traffic.

c. Gateway: The default gateway is a TCP/IP configuration item that is the IP
address of a directly reachable IP router.

MNetwork Settings

Modif‘: | Applychangesl Close I

Click Apply Changes to begin
programming the DeviceMaster.

Click Yes to the WARNING popup

21|

" Disable I
message.  DHCPIP
warninG i @ Static

The IP address specified will set to device

1P Address: I 192.168.11.20|
Subnet Mask; I 255,255.0.0
Gateway: I 192,1658.11.1

Do you wank ko conkinue?

es Mo |

Click Yes to the next WARNING popup
message about rebooting the
DeviceMaster.

R X

In order ko communicate with the device using the
new IP address, the device must be reset,

Iodify: I Applychangesl

Close |

Do you want to reset the device now?

]

Mo |

If you do not reboot the DeviceMaster at this time, the IP address is not
implemented on the DeviceMaster. Failure to reboot at this time can cause
network communication problems later, if the IP address is not programmed
into the DeviceMaster. Comtrol support recommends rebooting the
DeviceMaster at this point.

Click Close to return to the Device General tab.

Optionally, you can click the Advanced tab and verify that the Device Status
message indicates that the Device is active and Ok.

After programming the IP address, you may need to do the following:
¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.
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Setting Up DHCP After associating the DeviceMaster with the MAC address you can configure the
driver to work using DHCP.

1.

ouk Wb

Before programming an IP address it is critical that the DeviceMaster be
operational (the PWR or Status LED is lit) when configured for the MAC
address (Associating the MAC Address on Page 34).
Note: If the DeviceMaster is NOT operational, do NOT attempt to program or
use an IP address with the DeviceMaster.

Highlight the Device Name of the DeviceMaster that you want to configure.
Click the IP Mode radio button.
Click the Network Settings button.
Click the Modify button.

| Disable 1P

€ BHER I

£ Static 1P

1P Address: I 192,168.11.20
Subnet Mask; IW
Gateway: |192.168.11.1
MDdiFkJ Apply Changes | Close I
Click DHCP IP. This option allows 2 x|
DHCP to assign the IP address. Make
sure that you provide the MAC address
of the DeviceMaster for the network L
administrator to assign a static IP % DHCP IP
address from the pool. The DHCP  static 1P
server should assign the IP address,
mask, and IP gateway. Paddess: [ozresiia
Click Apply Changes. Subnek Maski |25 255 0.0
Click Yes to the WARNING popup Gateway: [152.18.11.1
message.
warning X
The IP address specified will enable DHCP and disable static IP access Madify I Apply CH~oges | Close |
Do you wank ko conkinue?
o |

Click Yes to the next WARNING popup
message. (warRNING S
If you do not reboot the DeviceMaster at this R E e D

time, the IP address is not implemented on
the DeviceMaster. Failure to reboot at this
time can cause network communication _ wo |
problems. Comtrol support recommends A

resetting the DeviceMaster.

Do you want to reset the device now?

After the DeviceMaster reboots, the following occurs:

e The Comtrol Drivers Management Console displays the IP address (0.0.0.0)
and subnet mask (255.255.0.0) values in the Network Settings popup.

¢ PortVision DX will display the IP address assigned by DHCP.
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10. Click Close to return to the Device General tab.

11. Optionally, you can click the Advanced tab and verify that the Device Status
message indicates that the Device is active and Ok.

12. After programming the IP address, you may need to do the following:
¢ Configure device properties, see Configuring Device Properties on Page 38.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 41.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 50.

Configuring DeviceMaster Ports as Sockets

DeviceMaster ports can also be configured as sockets. To configure sockets, use the
following procedure:

1. Use one of these methods to open the socket configuration web interface
(SocketServer).

¢ In PortVision DX, right-click the DeviceMaster and click Webpage.

¢ Enter the IP address of the DeviceMaster in your web browser URL field or
highlight the DeviceMaster in PortVision DX and click Web Manager.

2. Click the port number that you want to configure as a socket.

= o o

P - e o.n.-’
= Comtrol Corporation - Dev... | | UL L8 228

N
ComtROL’ DEVICE MASTER

Network Security EMail REC1006

| & http://192.168.11.23/home.asp L~ |

Server Status o

Software: NS-Link 9.36 IPv4 Config: Static IPv6 Config: Disabled
Host Name: Address: 192.168.11.23 Address: ::/0
Netmask: 255.255.0.0 Gateway: ::

Gateway: 192.168.11.1

Connection Status

Port 2 Port 3 Port 4
Port Name: Serial Printer Bar code reader Scanner
NSLink Connection Status

00:1a:a0:3d:63:44 v

See the web page help system, if you need information about configuring sockets
or serial tunneling. Optionally, you can refer to the DeviceMaster Installation and
Configuration Guide.

The web page help is also available separately if you want a local copy on your
host system. The help files are on the Software and Documentation CD and the
latest version can be downloaded at: ftp://ftp.comtrol.com/dev_mstr/rts/software/
SocketServer/help/ssvr_help.zip.
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Enabling Secure Data Mode

In addition to enabling SSL mode in the driver, you must Enable Secure Data Mode

in the NS-Link web page. Use the following procedure to implement the Enable
Secure Data Mode option.

1. Access the NS-Link web page using one of these methods:
¢ Open your web browser, enter the IP address, and click enter.

¢ Right-click the DeviceMaster in the Device Tree or Device List pane in
PortVision DX and click Webpage.

2. Click the Security tab.
3. Click Enable Secure Data Mode and Save.

o

™~
ComtROL’ DEVICE MASTER

Server Status Network EMail RFC1006

=N~

-+ P

= Comtrol Corporation - Dev... | | UL 2af 52

& http://192.168.11.23/securityCfc D~ |

Security Configuration

Enable Secure Data Mode

Enable Secure Config Mode

Enable Telnet/ssh

Enable Monitoring Secure Data via Telnet
Enable SNMP

OO0 & OlE

| Undao Changes | | Save |

< >

4. Configure your security key and certificate and click Set.

Key and Certificate Management

RSA Key pair used by SSL and SSH servers factory |E|
RSA Server Certificate used by SSL servers factory |£|
DH Key pair used by SSL servers factory |E|
Client Authentication Certificate used by SSL servers none |E|

Click the Help button if you need information about key and certificate
management.
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Using Driver Configuration Files

The Comtrol Drivers Management Console supports saving device driver

configuration files, which provides:

e Back-up for existing driver configuration settings

e Ability to configure multiple of the same devices with the same configuration

parameters

e Save the driver configuration settings because you need to remove a driver
version to install a new driver version and you want to reload the driver
configuration settings into the new driver

Note: Configuration files must be for the same model with the same port density.
For example, you cannot load a DeviceMaster PRO configuration file onto a
DeviceMaster RTS or a configuration file for a 32-port DeviceMaster RTS

onto a 4-port DeviceMaster RTS.

Configuration files are saved with a .DCF extension.

Saving Driver Configuration Files

Use the following procedure to create and save a configuration file.

1. After configuring the device and ports, click Save Configuration.

& Comtrol Drivers Management Console

-~ DeviceMaster
) BB DeviceMaster RTS, 2 Port, 25
[ ¥ Portol(coMs)

Port 02 (COMS)
2B Yrro - Rocketiing Console Ports|
N Serial Hub - RocketLinx Ports

RocketPort Infinity/Express
- RocketPort/RocketModem

General | Advanced

Network Connection Mode
(F)MACMode  00CO4E 17FFFB
@) IP Mode 192.168.11.20
[Z]Enable SSL Mode:
[T server Certificate
Client Certificate:

Device Settings
Device Name:

User-Friendly Device Name:
Keep Alive Timeout (seconds):
TCP Timeout Multiplier:

Scan Rate (ms):

Verbose EventLog

Network Settings
Reboot Device
DeviceMaster PRO, 8 Port
PRO - Rocketlinx Console Ports
120 (Default: 120)
1 (Default: 1)
10 + (Default: 10)

[] (Troubleshoating Only)

Defaults

Comtrol Drivers Management Console version 3.00
Copyright (C) 2011-2014 Comtrol Corporation.

@D[md —||

ok || Cancel | Apply [

Help |
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2.

Optionally, change the default file name and click Save.

€ Savelds =
\:}Q [« 1_Work Files » Backup_Config_Files ~ [ 6 ][ search Backup_Config Fies P |
I E- @
I8 Downloads ~ *  Name Date modified Type
] Recent Places . .
: 5] DeviceMaster LT, 16 Port.DCF DCF File
=] DeviceMaster Serial Hub, 8 Port,DCF A DCFFile
9 Libraries = ¥
= 5] PRO_P1_Com103.DCF DCF File
=] Documents L = )
- £ 2] PRO_P2_Coml08.DCF DCF File
o Music = -
e Z] PRO-Console Ports.DCF 3 DCF File
I Pictures = SH_P3_Com107.DCF 11 DCF File
£ videos = B
2] SH_P4_Com101.DCF 1 DCF File
5] SH_P5_Com100.DCF 1 DCF File
% Computer = g
4 5] SH_P6_Com105.DCF 1 DCF File
&, Local Disk () = : ) -
5] SH_P7_Com106.DCF 10 AM  DCFFile
¢ Gallery (\SIDEW] _ = .
[ IEAIORG - RocketLiny Console Ports.DCH] -
Save as type: Driver Canfiguration File (*.DCF) -
' Hide Folders [ cancel |

Loading a Driver Configuration File

You must have previously saved a configuration file before you can load a
configuration file.

The driver configuration file uploads in portions:

Loading Device
Configuration

1.

If you highlight a device and click Load Configuration and Apply for the device-
level configuration parameters to reload on the device.

To load port-level configuration parameters, you must highlight a single port
and click Load Configuration and Apply. You must upload each port's
configuration parameters separately.

Use the following procedure to load the configuration file for device-level
information for your device.

If necessary, open the Comtrol Drivers Management Console using one of these
methods:

e  Windows Control Panel; go to your Control Panel and click on the
Comtrol Drivers Management Console.

e  Shortcut; located under Start > Program Files > Comtrol > Product_Name >
Comtrol Drivers Management Console.

Depending on your operating system, you may need to click Yes to the Do you
want to allow the following program to make changes to this computer? User
Account Control message.
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3.

level settings from the configuration file.

In the left pane, highlight the device for which you want to load the device-

& Comtrol Drivers Management Console

RocketPort Infinity/Express
RocketPort/RocketModem

General | Advanced

Network Connection Mode

(7)MACMode 00 CO 4E 17FFFB
@ IP Mode 192.168.11.20
[Z]Enable SSL Mode:

[T server Certificate
Client Certificate:

Device Settings
Device Name:

User-Friendly Device Name:
Keep Alive Timeout (seconds):
TCP Timeout Multiplier:

Scan Rate (ms):

Verbose EventLog

Network Settings
Reboot Device

DeviceMaster PRO, 8 Port

PRO - Rocketlinx Console Ports

120 (Default: 120)
1 (Default: 1)
10 ~ (Default: 10)

[] (Troubleshooting Oniy)

Defaults

Copyright (C) 2011-2014 Comtrol Corporation.

Comtrol Drivers Management Console version 3.00

o) [ ]

Apply [

Help |

Save Cunﬁguranun[ Load, Eunﬁgurahud [

Click Load Configuration.

5. Browse to the location of the configuration file that you want to load.

Highlight the configuration

file and click Open. The
configuration file loads in a
few moments.

Make the appropriate

choice for your situation:

Click No to the
ComitrolApplet message,
if you are using the file
to set up multiple
devices with the same
device-level settings.

Click Yes to the
ComtrolApplet message,
if you are using the file
to restore a specific
device. For example,

%l Recent Places

n

4 Libraries
=] Documents
& Music
|5 Pictures

B videos

18 Computer
&, Local Disk (C3)

€ open =
.
( 1S [ 1 « Backup_Config_Files » DM_2014_April = \&,\ | search DM_2014 Aprit ol
Organize » Mew folder = O @
e 4+ Name ’ Date modified
B Desktop =] PRO - RocketLinx Console Ports.DCF 4/2/2014 303 PM
8 Downloads =] Serial Hub - RocketLin Ports.DCF 4/2/2014 304 PM

<

.

4% Gallery (\SIDEWINDER) (G) =

File name: PRO - RocketLinx Console Ports. DCF ~ | Driver Configuration File (~DCF =

b

you needed to remove and then re-install the DeviceMaster NS-Link device

driver.

ComtrolApplet

C% 'MAC address”, "IP address”, "User-Friendly Device Name" may conflict

¥’ with your current settings.

Do you want to load these settings?

8. Click Apply so that the configuration is saved on the device.

9. Go to the next procedure if you want to restore port settings from a
configuration file.
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Loading Port
Configuration

Use the following procedure to load the configuration file for port-level settings for
your device.

Note: Device driver configuration files must be for the same model with the same
port density. For example, you cannot load a DeviceMaster PRO
configuration file onto a DeviceMaster RTS or a configuration file for a 32-
port DeviceMaster RTS onto a 4-port DeviceMaster RTS.

If necessary, open the Comtrol Drivers Management Console using one of these

methods:

e  Windows Control Panel; go to your Control Panel and click on the
Comtrol Drivers Management Console.

e Shortcut; located under Start > Program Files > Comtrol > Product_Name >
Comtrol Drivers Management Console.

Depending on your operating system, you may need to click Yes to the Do you
want to allow the following program to make changes to this computer? User

Account Control message.

In the left pane, highlight the port for which you want to load the port-level
settings from the configuration file.

- DewiceMaster

()--%& DeviceMaster RTS, 2 Port, 28
Lo @ partnt froma

Load on a port by port basis.

Port 03 = Spare Port {COM12)

ES8510-XTE (COM110)

ES8510 (COM103)

E57510 (COM104)

Port 07 (COM17)

ES8508F-MM (COM109)

erial Hub - RocketLinx Ports

ES7506 (COM100)

Port 02 (COM20)

ES7510-XT (COM107)

ES7528 (COM101)

Port 05 (COM23)

ES9528-XT (COM105)

ES8510-XTE (COM106)

- 5 Port 08 (COM26)

o} RocketPort Infinity/Express

{2 BB RocketPort EXPRESS, Octa, DBY, PCle
e W porto1(coM2n

7

é‘

0

DRI

General |

Port Settings
RSMode: 232 - RTS Toadle
Override and Lock Baud Rate to: ~ None - Options
Transmit Data Timeout on Port Close: 0 + (seconds)

[[IMap 2 Stop Bits to 1

[ Wit on Physical Transmission before Completing Write
[ Emulate Modem Hardware RING Signal

[ Allows Parity Conflict (DeviceMaster 1 Port only)

[ Block PlugN-Play Search for Attached Serial Device
Defaults

Clone

[] Apply These Settings to All Ports

Port Name

UserFriendly Port Mame: ~ ES8509-XT

COM Name: |COM102 ~J

[T Renumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 3.00
Copyright {C) 2011-2014 Comtrol Corporation.

QK ] [ Cancel Apply

[Save Configuration M Load Conﬁguratun} [
el

Click Load Configuration.

Browse to the location of the configuration file that you want to load.
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6. Highlight the configuration file and click Open. The configuration file loads in

a few moments.

& Downloads

| RecentPlaces

w4l Libraries
3 Documents
.J"- Music
[ Pictures

BB videos

18 Computer
& Local Disk (C)

G Open @
Q\:/, | <« Backup_Config_Files » DM_2014_April - |4’ ‘ | Foren ol
Organize » New folder = - 'f).-'
¢ Favorites = Name : Date modified

Bl Desktop =] PRO - RocketlLinx Console Ports.DCF 4/2/2014 3:03 PM

¢ Gallery (WSIDEWINDER) (G:)

\Z| Serial Hub - RocketLinx Ports.DCF 4/2/2014 3:04 PM

- 4 1 +

File name: PRO - Rocketlink Console Ports.DCF + IDrlver Configuration File (~.DCF 'J

[ Openkﬂl Cancel |

7. Make the appropriate choice for your situation:

Click No to the ComtrolApplet message, if you are using the file to set up

multiple devices with the same port-level settings.

DeviceMaster NS-Link device driver.

Click Yes to the ComtrolApplet message, if you are using the file to restore
a specific device. For example, you needed to remove and then re-install the

ComtrolApplet

¥ current settings.
Do you want to load these settings?

"User-Friendly Port Name", "COM Name" may conflict with your

| [

[ Yes

Nnh]

8. Click Apply so that the configuration is saved on the device.
9. Repeat Steps 3 through 8 for each port that you want to restore.
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Removing the DeviceMaster and Driver

This section discusses:

device driver from your system

Removing a DeviceMaster

Removing a DeviceMaster from an installation without removing the NS-Link

Removing the NS-Link Device Driver from your system

Use the following procedure to uninstall the device driver.

Note: Administrative privileges are required to remove device drivers on Windows
operating systems newer than Windows Server 2003.

1. Right-click the DeviceMaster that you want to uninstall in the Tree View

pane.

2. Click Uninstall.

G Comtrol Drivers Management Consaole

Disable
Uninstall

Properties

General | Advanced

Network Connection Mode
@ 00 CO 4E 40 FF FO

192.168.11.61

RocketPort/RocketMot

Enable S5L Mode
Server Certificate
Client Certificate:

Device Settings
Device Name:

UserFriendly Device Name:

Metwork Settings
Reboot Device

DeviceMaster LT, 16 Port

DeviceMaster LT, 16 Port

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ~ (Default: 10)
Mumber of Devices to Load at Once: 20 (Default: 20)
Do NOT Load Firmware to Device D
Verbose Eventlog [] (Troubleshooting Only) Defaults
Comtrel Drivers Management Console version 2,11
Copyright {C) 2011-2013 Comtrol Corporation. [Save Configuration ] [Lnad Configuration ] [ oK ] [ Cancel ] Apply
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Removing the NS-Link Device Driver

Use the following procedure to remove the DeviceMaster device driver.

1.
Comtrol > DeviceMaster > Driver

2.
Click Remove All and Next.

Comtrol Driver Installation wizard il

From the Start button, click the shortcut for your DeviceMaster: Programs >

Installation Wizard.

Click Next to start the Comtrol Driver Installation Wizard.

Install, Update, or Uninstall driver
Select the operation you wish to perform:

0 Instal
Select this option to install a new device and
update the associated driver(s).

" Update
Select this option to update the driver(s) for the
existing device(s).

& Remove Al

Select this option ko remove the existing device(s)
and uninstall al the associated driveris).

< Back | Nex§> I Proceed

Cancel

M

4. Click Next to remove the driver.

Comitrol Driver Installation wizard |

Device & Driver Clean-up

‘¥ou are about ta remave one or maore Canntrol device(s)
fram this computer. This remawval may resultin loss of
communication with the device(s) and ultimately disrupt
wour operations, if any.

This process will remaove all Comtrol hardware, from the
fallowing product Family, that reside on this PC and use
any version of this driver assembly.

Product Family: DeviceMasker

Click Mext to continue or Cancel o exit this wizard,

Cancel

< Back | N%xt> I Froceed
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5. Click Proceed to continue the driver removal process.
X

Summary

Driver Package :  DeviceMaster ;I
Selected Action :  Remove Al
Device(s) : All DeviceMaster Units

IT IS HIGHLY RECOMMEMNDED TO CLOSE ANY ACTIVE
SERIAL PORT/APPLICATION EEFORE YOU PROCEED,
FAILURE TO DO SO WILL RESULT IN DATA LOSS |

=

Launch Comtral Brivers Management Console I

Click Proceed ko continue or Cancel to exit this Wizard,

< Back | Text = I Proceedhl Cancel

)

6. Click the Reboot My Computer button or Close.
| Comtrol Driver Installationwizard Xl

Summary

Analyzing the COM Mame Arbiter ... ;I
Analyzing the Registry ...

Cleaning up the Remaining Driver Files ...

Finalizing ...

Finished.

REMINDER.: < SYSTEM REBOOT IS REQUIRED =
-

Launch Comtrol Drivers Management Consale I

Rebaoot My Computer |

|

Press Close ko exit this Wizard,

= Back | Tt | Froceed I Clase
bag

e Ifyou click Close, make sure that you reboot the system and remove the
adapter to complete the driver removal.

e If you click Reboot My Computer, click OKk.
x|

Flease make sure ka close your active programs and save your data,
. Click OK when yaou are ready to reboot the computer.

ol

7. Shutdown the system and disconnect the DeviceMaster from your network.
8. If you want to totally remove the .exe driver assembly:
a. Delete any copies of the .exe driver assembly file residing on the system.

b. Delete the driver and devices using the Add > Remove Programs Control
Panel.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your DeviceMaster and the
NS-Link device driver. You should review the following subsections before calling
Technical Support because they will request that you perform many of the
procedures or verifications before they will be able to help you diagnose a problem.

Houw to Find Diagnostic Tools and Utilities
Troubleshooting Checklist on Page 64
General Troubleshooting on Page 65

Connectivity Requirements on Page 66
DeviceMaster LEDs on Page 68

Using the Advanced Tab on Page 70

NS-Link Driver Troubleshooting on Page 75
Using Port Monitor to Test Ports on Page 76
Using Test Terminal on Page 79

How Disable/Enable the Device Driver on Page 85
Technical Support on Page 85

If you cannot diagnose the problem, you can contact Technical Support on Page 85.

How to Find Diagnostic Tools and Utilities

There are several tools and utilities that Comtrol provides to diagnose serial port
problems or to monitor data.

The Advanced tab in the Comtrol Drivers Management Console (Using the
Advanced Tab on Page 70), which may provide valuable information about the
DeviceMaster and your network, in the event that you are having problems.

PortVision DX (Page 7) that provides the following features:

- Auto-discover and organize Comtrol Ethernet attached products on your
network.

- Remotely access, manage, and configure Comtrol Ethernet attached
products from a central console.

- Load network configuration settings onto multiple Comtrol Ethernet
attached products - quickly and easily.

- Instantly view connection status, firmware revision, and network settings
of all servers.

- Configure serial ports using TCP sockets, port communication, and
interface settings.

- Visualize each server and port with instant links to connector, power, and
serial pinout information.

- Conveniently customize and save your network view and commands for
replication across all servers.

- Includes the Test Terminal (WCom2) and Port Monitor (PMon2) programs
for easy access.

- Test Terminal can be used to troubleshoot communications on a port-by-
port basis.

- Port Monitor can check for errors, modem control, and status signals. In
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Troubleshooting Checklist

addition, it provides you with raw byte input and output counts

Test Terminal and Port Monitor are installed and available if you install
PortVision DX. You can refer to the Port Monitor and Test Terminal User
Guide for testing procedures.

Troubleshooting Checklist

Most customer problems reported to Comtrol Technical Support are eventually
traced to cabling or network problems.

Reboot the system and reset the power on the DeviceMaster, watch the PWR or
Status light activity. See DeviceMaster LEDs on Page 68 for information about the
diagnostic LEDs.

e Ifthe DeviceMaster has a power switch, turn the DeviceMaster power switch

off and on.

e Ifthe DeviceMaster does not have a power switch, disconnect and reconnect

the power cord.

PWR or Status LED Description
5 sec off, 3 flashes, 5 sec off, 3 flashes ... Redboot checksum failure.
5 sec off, 4 flashes, 5 sec off, 4 flashes ... SREC load failure.
5 quick flashes Ege default application is starting
10 sec on, .1 sec off, 10 sec on .1 sec off ... |The default application is running.

The following table may help you diagnose your problem:

Issue

Check

Cabling?

Verify that you are using the correct types of cables on the correct
connectors and that all cables are connected securely using the
DeviceMaster Installation and Configuration Guide (Page 7).

Network?

Isolate the DeviceMaster from the network by connecting the
DeviceMaster directly to a NIC in a host system.

See Connectivity Requirements on Page 66 for network
cabling information.

Reduce network traffic by installing a second NIC in the host
and connect directly to the DeviceMaster.

Verify that the Ethernet hub, switch, or router and any other
network devices between the system and the DeviceMaster
are powered up and operating.

Correct MAC
address?

Verify that the hardware MAC address in NS-Link matches the
address on the DeviceMaster label. You can also use PortVision
DX to verify the MAC and IP addresses.

Correct IP
address?

Verify that the network IP address is correct. If IP addressing
is being used, the system should be able to ping the
DeviceMaster.

Verify that the IP address programmed into the
DeviceMaster matches the unique reserved IP configured
address assigned by the system administrator.
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General Troubleshooting

Issue Check

If using the NS-Link device driver with an in-house application,
verify that you are addressing the port correctly. In many
applications, device names above COM9 require the prefix \\.\
in order to be recognized. For example, to reference COM20, use
\W\COM20 as the file or port name.

Correct port
addressing?

Is this the

Latest Driver? |S¢€ Checking the Device Driver Version on Page 20.

Test the Port Install PortVision DX (Page 10) and use Test Terminal (Page 79).

or Ports?

Comtrol Verify that the DeviceMaster has installed using the Comtrol
Drivers Drivers Management Console to confirm that the DeviceMaster
Management |displays. Install the device driver, if the DeviceMaster is not
Console? displayed.

Enable Enable the Verbose Event Log feature on the Device General and

Verbose mode |then reboot the system.

Note: If you have a spare DeviceMaster, try replacing the DeviceMaster.

General Troubleshooting

This table illustrates some general troubleshooting tips.
Note: Make sure that you have reviewed the Troubleshooting Checklist on Page 64.

General Condition Explanation/Action

Indicates that boot program has not downloaded to the
DeviceMaster.

1. If applicable, remove the NS-Link driver.

2. Make sure that you have downloaded the most
current driver from ftp:/ftp.comtrol.com/dev_mstr/
rts/drivers/win7.

PWR or Status LED
flashing 3. Install the driver and configure the DeviceMaster
using the MAC address. Make sure that you reboot
the system. Refer to NS-Link Device Driver
Installation on Page 15 for installation
information.

Note: If the PWR or Status LED is still flashing,
contact Technical Support.

PWR or Status LED not |Indicates that power has not been applied or there is a
lit hardware failure. Contact Technical Support.
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Connectivity Requirements

General Condition

Explanation/Action

Can ping the Comtrol
device, but cannot open
the ports from a remote
location.

(You must have
previously programmed
the IP address, subnet
mask, and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to
communicate with the DeviceMaster.

When using a sniffer to track NS-Link packets,
filtering for Port 4606 will easily track the packet. The
packet should also contain the MAC address of the
DeviceMaster and the originating PC so that it can be
determined if the packet is able to travel the full
distance one way or not.

If the 4606 packet is found on one side of a firewall or
router, using sniffer, and not on the other side, then
that port needs to be opened up to allow the 4606 to
pass.

This will most often be seen with firewalls, but is also
seen in some routers.

Cannot ping the device
through Ethernet hub,
switch, or router

Isolate the DeviceMaster from the network. Connect
the DeviceMaster directly to the NIC in the host
system (see Connectivity Requirements on Page 66).

Cannot ping or connect
to the DeviceMaster

The DeviceMaster family default IP address is often
not accessible due to the subnet masking from another
network unless 192.168 is used in the network.

In most cases, it will be necessary to program in an
address that conforms to your network.

If you do not use the NS-Link driver to program the IP
address, you only have 10 seconds to disable the
bootloader with Redboot to get into the setup utility.

See the DeviceMaster Installation and Configuration
Guide (Page 7) for the Redboot method of programming
an IP address.

Connectivity Requirements

An Ethernet connection: either to an Ethernet hub, switch, or router; or to a
Network Interface Card (NIC) in the host system using a standard Ethernet cable.
See the DeviceMaster Installation and Configuration Guide (Page 7) for
information regarding hardware installation.

Product Type Connected to |Connector Name
. Hub, switch,
DeviceMaster RTS 1-port router, or NIC 10/100 ETHERNET
. Hub, switch, RdJ45 port (not
DeviceMaster RTS Embedded router, or NIC  |labeled)
NIC
DeviceMaster RTS 2-port 1E Hub, switch, or |10/100
router
NIC
DeviceMaster RTS 2-port 2E Hub, switch, or |10/100 1E/2E
router

66 - Troubleshooting and Technical Support

DeviceMaster Driver User Guide: 2000595 Rev. A



Connectivity Requirements

Product Type Connected to |Connector Name
. NIC DOWN
DeviceMaster RTS 4/8/16-port -
(external power supply) Hub, switch, or |{;p
router
DeviceMaster RTS 16/32RM Hub, switch, 10/100 NETWORK
(internal power supply) router, or NIC
NIC DOWN
DeviceMaster PRO 8/16-port Hub, switch, or
router up
NIC DOWN
DeviceMaster Serial Hub 8-port [y, switch, or
router up
DeviceMaster Serial Hub 16-port | 222> sWitch, 174,100 NETWORK

router, or NIC
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DeviceMaster LEDs

DeviceMaster LEDs

Port LEDs

Network and Device
LEDs

The DeviceMaster has network and port LEDs to indicate status.

Port LEDs are amber and green on 4, 8, 16, and 32-port. The 1-port and 2-port
models do not have port LEDS. After a port has been opened in RS-232 mode, an
amber LED means that there is link between the port and the serial device. After
a port has been opened in RS-422 or RS-485 mode, an amber LED means that data
is receiving data. A green port LED indicates transmit activity.

The LEDs indicate that the default DeviceMaster application, SocketServer is
running or after driver installation, that the NS-Link driver loads. If you have
loaded PortVision DX, you can check the DeviceMaster status on-line.

Ports

Model

Network LEDs

DeviceMaster
RTS

The Status LED on the front of the unit is lit, which indicates that
it has power and has completed the boot cycle.

Note: The Status LED flashes while booting and it takes
approximately 15 seconds for the bootloader to complete
the cycle. When the Bootloader completes the cycle, the
LED has a solid, steady light that blinks approximately
every 10 seconds.

The red Link Act LED is lit, which indicates a working Ethernet
connection.

If the red Duplex LED is lit, it indicates full-duplex activity.

If the red 100 LED is lit, it indicates a working 100 MB Ethernet
connection (100 MB network, only).

DeviceMaster

Embedded

The LEDs are located between the RJ45 connector and the power
terminal block.

The amber Status LED (D1) on the adapter is lit, which indicates
that it has power and has completed the boot cycle.

Note: The Status LED flashes while booting and it takes
approximately 15 seconds for the bootloader to complete
the cycle. When the Bootloader completes the cycle, the
LED has a solid, steady light that blinks approximately
every 10 seconds.

The red Link Act LED (D2) is lit, which indicates a working
Ethernet connection.

If the red Duplex LED (D3) is lit, it indicates full-duplex activity.

If the red 100 LED (D4) is lit, it indicates a working 100 MB
Ethernet connection (100 MB network, only).

DeviceMaster
RTS

The STATUS LED on the device is lit, indicating you have power
and it has completed the boot cycle.

Note: The STATUS LED flashes while booting and it takes
approximately 15 seconds for the Bootloader to complete
the cycle. When the Bootloader completes the cycle, the
LED has a solid, steady light that blinks approximately
every 10 seconds.

If the LINK (green) LED is lit, it indicates a working Ethernet
connection.

If the ACT (yellow) LED flashes, it indicates network activity.
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Network and Device LEDs

Ports Model

Network LEDs

4 DeviceMaster
PRO (8)

8 DeviceMaster
RTSY

16 | DeviceMaster
Serial Hub (8)

The PWR LED on the front of the unit is lit, which indicates it
has power and has completed the boot cycle.

Note: The PWR LED flashes while booting and it takes
approximately 15 seconds for the bootloader to complete
the cycle. When the Bootloader completes the cycle, the
LED has a solid, steady light that blinks approximately
every 10 seconds.

The red LNK/ACT LED is lit, which indicates a working Ethernet
connection.

If the red 100 LED is lit, it indicates a working 100 MB Ethernet
connection (100 MB network, only).

DeviceMaster
PRO (16)
16
DeviceMaster
RTS++

32 | DeviceMaster
Serial Hub
(16) .

The Status LED on the front of the unit is lit, which indicates it
has power and has completed the boot cycle.

Note: The Status LED flashes while booting and it takes
approximately 15 seconds for the bootloader to complete
the cycle. When the Bootloader completes the cycle, the
LED has a solid, steady light that blinks approximately
every 10 seconds.

The red LNK/ACT LED is lit, which indicates a working Ethernet
connection.

If the red Duplex LED is lit, it indicates full-duplex activity.

If the red 100 LED is lit, it indicates a working 100 MB Ethernet
connection (100 MB network, only).

1 External power supply.
1 Internal power supply.
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Using the Advanced Tab

Using the Advanced Tab

You can use the Advanced tab to get a summary of the DeviceMaster status. The
Advanced tab can be useful for troubleshooting network problems with your
DeviceMaster.

Note: To use the Advanced tab, you must associate a MAC address to the
DeviceMaster before programming an IP address (Page 34).

Use the following procedure to access the Advanced tab.

1. If necessary, access the Comitrol Drivers Management Console.
2. Highlight the DeviceMaster.

3. Click the Advanced tab.

Comtrol Drivers Management Console N 21|

DeviceMaster 1= General Adwanced |
= Ao Dg\_fi:eMaster PRO 8 Port {DeviceMaster PR

: F Port o1 (comil) ~Device Status
o S port 02 (Comiz)

;j Part 03 (COM13) Device is active and Ok, Refresh
7 port 04 (COML4)
o S Port 0 (Com1s) History
o S Part 06 (COMLE)
A port 07 (ComL7)
o S port 08 (Comie)

E| A Dg\_fi:eMaster RTS 4 Port (DeviceMaster RTS
7 Port o1 (comis)
o S Port 02 (Comzo)

j :: 33 Eggmgg PC Metwoark Interface Details
-~ RocketPort Infinity /Express o
- B RocketPort Express & Port, PC1e-BUS (Rocks LS eeten blsiscs La"sl
5 port 01 (Coms)
e S port 02 (Com4)
Port 03 (COMS)
F Part 04 (COME)

e S port 05 (Com7)
i

[~ Metwork Statistics

Port 06 (COME)

9 port 07 (oMY =
4 »

Comtrol Drivers Management Consale version 1,01
Copyright {C) 2011 Comtrol Corporation, Save Configuration | Load Configuration | oK I Cancel | Anly | Help

Note: You must have previously associated a MAC address to the
DeviceMaster (Associating the MAC Address on Page 34).

Refer to the Device Status table (Page 73) for a list of messages and
explanations.

4. You can click the History button to review the last ten actions on the
DeviceMaster.

2012-01-04 16:05:09  Code upload has completed,

2012-01-04 16:05:11  Device detected, initializing ...
2012-01-04 16:05:18  Initialization complete, Waiting on response from devio

2012-01-04 16:05:18  Device is ackive and O,

L bl

2012-01-04 16:17:19  Device detected, initializing ...
2012-01-04 16:17:50  Device detected, microcode upload in progress,

2012-01-04 16:17:59  Code upload has completed,

E
-~
a2l L
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Using the Advanced Tab

5. Click PC Network Interface Details for the following information.

PC Network Interface 2xl

Statistic

MAC Address : FD 14 A0 30 63 44
Frames QOut W
Frames Accepted IW
Frames Passed On : lqzzm—

Adapter 1 ID String l‘\DE\"ICE'I,{?CDS?DE'D-SZ?Z-‘IF13-AF36-8085521EDCBE}

Help | Reset |

Field

Description

MAC Address

MAC Address is the reported MAC address of the Ethernet network
interface card (NIC) card in the server. Since a server may contain
more than one NIC, identifying exactly which NIC is being used by
the device driver may help you to identify and resolve problems.

Frames Out

Frames Out is the count of the number of frames output by the device
driver through the identified network interface. This includes all
administrative, data, and control frames, and should be incriminated
whenever the DeviceMaster and the device driver are operating, even
if the DeviceMaster is idle.

Frames
Accepted

Frames Accepted is the count of the number of received frames
accepted by the device driver for further processing. These must be
well-formed packets with the correct protocol identifiers for the device
driver.

Frames Passed
On

Frames Passed On is when a NIC receives a packet, it passes the
packet around to each driver or application that is bound to the NIC
until one of them recognizes and accepts the packet.

Adapter 1 ID
String

Adapter 1 ID String is the NIC binding string. Every network entity
that needs to be uniquely identified has a Globally Unique Identifier
(GUID), which is used to form unique binding strings. The presence of
this string indicates that the device driver has been bound to a
specific NIC.

Reset

This button resets the statistics in the PC Network Interface window.

6. Click Close to return to the Advanced tab.
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7. Click the Device Network Interface Details button to review the following

information.
Skatistic:
MAC Address : FU CO4E 17 FFFB
Packets to : #
Packets from #
Retransmitted [ % of All Sent : { 0%
Reported State : V
Devices Detected | Available : 3/0
Qut OF Sequence [ % of all Received f 0%
Maximum - Average Buffer Usage IW
Buffer Allocation Failures : #
Starving Partis) : -
Help | Reset | C|DD$ |
Fields Description

MAC Address is the network (MAC) address of the DeviceMaster that

MAC Address is currently selected. It should match both the MAC address on the
General tab and the MAC address on the physical DeviceMaster.
Packets To is the count of information frames sent to a layer in the
Packets To

device driver and indicates actual data traffic sent.

Packets From

Packets From is the count of information frames received by a layer in
the device driver, and indicates actual data traffic received.

Retransmitted/% All Sent is the percentage of information frames

Eﬁtgi?lstmltted/% requiring retransmission due to network errors. If this value is not
zero, you may have network problems.
Reported State contains a message showing the status of the device
Reported State driver to the selected DeviceMaster.

Devices Detected/

Devices Detected/Available is the number of DeviceMasters found on

Available the network and how many of the DeviceMasters are available.
Out of Sequence/ % of All Received is the percentage of information
(%ugl?fﬁ%i%?fge/ % frames received out of order, possibly due to network errors. If this

value is not zero, you may have network problems.

Maximum Average

Maximum and Average Buffer Usage is the percentage of the network

Buffer Usage buffer used since the driver was loaded.
. Buffer Allocation Failures displays how many times the driver failed to
?;flfe;ejskllocatlon allocate network buffers to the process because there were not enough
u buffers.

If any Buffer Allocation Failure happens, the Starving Port(s) list will
Starving Port(s) include the name of the COM port that could not be serviced

(immediately) because of it.

Reset clears the data values from the fields. and updates the data
Reset displayed in the event that you want review data before the automatic

refresh cycle occurs.

Click Close to return to the Advanced tab.
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The following table provides a list of Device Status messages.

Device Status Message

Description

A MAC address has not yet been
specified for this device. Return to
the General tab, configure the device,
and apply the changes.

The driver may have only been configured with an
IP address. The appropriate MAC address must be
input in the MAC field in the General tab so that the
Advanced tab can report DeviceMaster status.

Can't detect any Comtrol devices.
Check Ethernet connectors and
ensure the device is powered on.

Network traffic is being received, but not from a
DeviceMaster. Check the network connections and
verify that the DeviceMaster is powered up.

Can't detect the device with specified
the MAC address on any network.
Verify the MAC address of the unit,
check the Ethernet connectors and
ensure the device is powered on.

Network traffic is being received from a
DeviceMaster, but not the one specified on the
General tab. Check the DeviceMaster to make sure
that you are using the correct MAC address.

Code upload failed due to a timeout
and the driver is attempting to re-
synchronize with the device.

The device driver has not successfully uploaded the
firmware to the assigned DeviceMaster.

Code upload has completed.

The driver has completed uploading the firmware to
the DeviceMaster.

Code upload was restarted after a
timeout.

The firmware upload process failed due to a time-
out. The upload process has been restarted.

Device detected, initializing.

The server has acquired the DeviceMaster and is
downloading the control program. The DeviceMaster
will be available shortly.

Device detected, microcode upload in
progress.

The device driver is attempting to upload the
microcode to the DeviceMaster. This should
complete momentarily.

Device is active and OK, no data
traffic was exchanged since last
inquiry.

The DeviceMaster and ports are operational. There
is currently no active serial traffic.

Device is active and OK.

The DeviceMaster is okay and ready to use.

Device is detected and configured in
the driver, but is not yet assigned to
this server/PC.

Either the DeviceMaster is currently being
controlled by another server or the DeviceMaster
power has been cycled and the DeviceMaster is
waiting for a server to acquire it.

Excess out-of-sequence packets
received. Check for indications of
high network traffic.

Click the PC Network Interface Details button to
review the statistics, which may indicate that
DeviceMaster is functioning properly.

This message typically goes away on it's own but you
can reboot the PC so that the network traffic is re-
synchronized.

Excess packet retransmissions
detected. Check for indications of
high network traffic.

Click the PC Network Interface Details button to
review the statistics, which may indicate that
DeviceMaster is functioning properly. This message
typically goes away on it's own but you can reboot
the PC so that the network traffic is re-
synchronized.

Initialization complete. Waiting on
response from the device before
making the connection active.

Waiting for a response from the DeviceMaster.

Statistical data was reset.

This indicates the number of times that the
statistics in the PC Network Interface and Device
Network Interface have been reset.
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Device Status Message

Description

The driver is not running. If you just
installed the driver you will need to
exit the program before the driver
starts.

Close and then re-open the Comtrol Drivers
Management Console.

The communications between the
driver and the device has been
disrupted. Check connectors, cabling,
and look for indications of high
network traffic.

The DeviceMaster is off-line in this state. The MAC
or IP address for the DeviceMaster is known
(assigned) but communications have been
interrupted.

The device has failed to respond for
an extended period of time. The
device may have lost power or is in
an unresponsive state.

The device driver is no longer able to communicate
with the DeviceMaster. Check the LED status (Page
68).

The driver is not running. Make sure
the driver is installed correctly and
restart the PC to correct the
problem.

Make sure the driver is installed correctly and
restart the PC to correct the problem. The driver is
most likely disabled. Enable the driver and reboot
the PC.

Timeout occurred while the driver
was waiting for an ADMIN command
reply from the device.

There may be network traffic problems, an
unresponsive DeviceMaster, or a problem with the
server sending out network data.

The device driver is trying to locate the
DeviceMaster on the network by sending out the ID
request and not receiving a response from the
DeviceMaster, which may indicate that the
DeviceMaster is either not on the network, on a
different segment (if using MAC mode of
addressing), or the bandwidth of the network (or
server) is so saturated that the DeviceMaster
response is not received in time.

Timeout occurred while the driver
was waiting for an Assign Reply
response from the device prior to
making the connection active.

There may be network traffic problems, an
unresponsive DeviceMaster, or a problem with the
server sending out network data. A handshake that
occurs after an ID response is received and the
device driver is trying to establish a communication
channel with the DeviceMaster.

Unable to find a Network Interface

Install a NIC in that PC or check that the NIC is

Controller (NIC) card. operational.
The firmware has not uploaded to the DeviceMaster.
Uninitialized. If this message is displayed in the History file, it

often means that the DeviceMaster is in the process
of being rebooted.
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NS-Link Driver Troubleshooting

This table includes some tips related to NS-Link drivers.

NS-Link Condition

Explanation/Action

Need to program IP
address into the device.

Before programming an IP address it is critical that the
DeviceMaster be operational and passes the power on tests
when configured for the MAC address.

Note: Ifthe DeviceMaster is NOT operational, do NOT attempt
to program or use an IP address with the DeviceMaster.

See Program the IP Address (Network Information) on Page 11
for more information.

Cannot open port

1. Verify that MAC address in the NS-Link driver matches
the address on the DeviceMaster.

2. Verify that you are using the correct NS-Link driver. If
necessary, remove and reinstall a new driver.

3. Isolate the DeviceMaster from the network (see Page 65).

4. Check to see if another program or computer is active on
this port.

The Comtrol device has a
lower limitation of
network bandwidth
requirement of 64 Kbps.

At this speed the entire available bandwidth is required for the
purpose of uploading the firmware from the driver to the
DeviceMaster. At lower speeds, timing issues will prevent the
firmware from being successfully installed to the
DeviceMaster, thus preventing the DeviceMaster from normal
operation.

When using the DeviceMaster over a WAN link that is less
than the recommended 64 Kbps, a timing modification may be
made that will allow uploading of the firmware.

Load the driver locally to the DeviceMaster for the purpose of
getting the firmware installed. The PC on the other side of the
slow link can then “share” the port. The sharing may be
exclusive as the firmware loader PC may not need to access the
ports.
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Using Port Monitor to Test Ports

This procedure will check whether the DeviceMaster can:

e Communicate through the NS-Link device driver

¢ Determine if a port is open with an application

If necessary, install PortVision DX (Before Installing the Comtrol Drivers
Management Console on Page 9, Page 10).

1.

Open PortVision DX using the desktop shortcut.

2.

Start Port Monitor by clicking Tools > Applications > Port Monitor (PMon2).

1BV PortVision DX =N EoR =
File Manage View Help
¥ Refiresh All -
i E & 3| = =
— Scan Network - e - o
Scan  Refresh Al iehaat Notes | Help  About  Ext
Check for Updates .
Log File v b ES9528(0/9)
Applications y Customize ..
IPORTVI
Options .. Test Terminal (WCom2)
| Port Menitor (PMen2) 5
HyperTermima e
- Drivers |
Name : First Floor - E
 ESE510
vl v ESBS10-KTE
1 + 10-Link Master #1
/ Modbus/TCP
i * PRO - 17:FFFE
+ RTS_2E - 20:FFFS
Use menu or toolbar to add notes i+ ) RTSA - OT-FFFC
this area. .
SHE
B v UPL5-30VDC
" || B3 Foutth Floor [28/ 20]
L e Iy ey T ] i
+|[ & Device Name [ Model 1P Address MAC Address | Software Version [ status
By Esss ES0528 19216811105 00:CO4E3300:01 114 betod (11030  ON-LINE
L« 10-Link Master #1 I0-Link Master P-4 19216811199 00:CO4E3%:FFF6  EtherNet/IP 083 ON-LINE
=l |® v Modbus/Tce UP-1P (5Y) 1921681153  00:COMEAS047A Modbus/TCP 5,07 ON-LINE
B o B PRO - 17FRFE PRO-8P (DES) 1921681120  00:COMEATFRFB NS-Link 803 ON-LINE
By RTS4-OTFRFC RTS-4P (DES) 1921681123  00:COEOTFRFC NS-Link9.11 ON-LINE
B RTS2E-20:FRFS RTS-2P (26) 1921681152  00:COE9FRFS SocketServer9ll ON-LINE
B SH SH-8P (DBS) 1921681114 00:COAEACFRFD NS-Link 911 ON-LINE
B UPLS-30VDC UP-1P (5-300) 1921681155  00:COME2L05:CD Modbus Server 404 ON-LINE
4 n »
First Floor | |1 Ready
3. Click Add Ports using the icon or Tools > Add Ports,
[ Untitled - PMon2 = ]
File Tools Vi e
D& ww BE?
Port Mame | $atus g ports PSR | €O | RTS | DTR [ Actuel Throughput TxTotal RaTotal | Total Eners | OverrunErrors | FramingErrors | ParityErrors
CoM4 CINGED OFF Opf OFF OFF OFF 0 0 0 0 0 0
COMS CLOSPB~aer—TFF OFF OFF OFF 41970289 41966658 O 0 0 0
COME CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMg CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI0  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIL  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI2  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIS  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMZ5  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COM26  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOD  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOL  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI02  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI03  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI04  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI05  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOS  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI07  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI08  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI09  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
« [ L3
Add one or more port 1o the list Polling timeris ON NUM
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4. Click Driver, RPSHSI/NSLINK, and click Ok.

Add Ports ... =]

COM1 -

COM2 Cancel
COM3

COm4

COMS

COME

COM?7

COmME

COm3a

0

" Range

Foar example: 3-15.21,45.51-66,74

* Driver
[~ ROCKETPORT INFINITY / EXPRESS
v DEWICEMASTER / MSLINK
[~ ROCKETPORT / ROCKETMODEM
[ WSLIMK

If the DeviceMaster is communicating with the device driver for Windows,
Port Monitor should display CLOSED status. If a port is open for an
application, it displays as OPEN, and displays Actual Throughput, TxTotal and
RxTotal statistics.

L=

File Tools Wiew Help

DS HS v 0F 2

Part Narme | Status | TS I DSk | [l] | RTS | DTR | Actual Throughput | TxTotal | RxTatal | Tatal Errors | CwerrunErrors
COM11 CFEM Loy QR Lo\ Qb eV 114600 [| 205591 209638 ] 1]
COM1z CLOSED |OFF  (OFF  |OFF |OFF |OFF u] 1] u] ] 1]
COM13 CLOSED |OFF (OFF  |OFF |OFF |OFF u] 1] u] ] 1]
COM14 CLOSED OFF  (OFF  |OFF  |JOFF  |OFF u] 1] u] ] 1]
COMIS CLOSED |OFF  |OFF  OFF  (OFF  OFF 0 a a 1] o
COMI1G CLOSED |OFF OFF OFF  OFF  OFF 0 a a 1] 1]
COM17 CLOSED |(OFF |OFF |OFF |OFF |oFF [ u] 1o u] 0 1]
COM15 CLOSED |OFF OFF |OFF |OFF |oFF [ u] 1o u] ] 1]
| | 0
Ready Polling timer is ©Oh MM 4

Normally, there should be no data errors recorded or they should be very
small. To find out what the actual errors are, scroll to the right. You will see
three columns: Overrun Errors, Framing Errors, and Parity Errors.

If the errors are:

Overrun Errors represent receive buffer overflow errors. If this is the case,
you will have to configure either software or hardware handshaking to
control the flow of data. The most common errors are Overrun errors.

Framing Errors indicate that there is an synchronization error between the
beginning of a data frame and the end of the data frame. A frame usually
consists of a start bit, 8 data bits, and a stop bit or two. The framing error
occurs if the stop bit is not detected or it occurs in the wrong time frame.
Most causes for framing errors are electrical noise on the data lines, or
differences in the data clocks of the DeviceMaster and the connected device.

Parity Errors occur when parity is used and the parity bit is not what is
expected. This can also be caused by noise on the data lines.
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6. You can view additional statistics to Port Monitor by adding columns. Click

Tools and Add Columns.

B Untitled - PMon2 i
File | Tools Wiew Help

5

[T

2 0 O 0y 0 [ 5 =

Add Ports
Remave Parts

Remave @Iumns

Reset Yalues
Default Columns

Setkings

=lol x|

B E|?]

| Actual Throughput | TxTotal

| RxTokal

| Tokal Errars | CrverrunErrors

FramingErrars ParityErrors

]

(== | ]| ] | | | ] |

64923300

coooooo

64923300

coooooo

0
1}
1}
0
0
0
0
1}

coooooooo

cooooooo
ocooooooo

7. Highlight or shift-click to add multiple statistics and click OKk.

Add / Remove Columns ...

Flease select the columns ..

ParityE rrars
Statuz Flags
TuPackets
Fi=Packets
TxTatalF aw
Fi=TotalF aw
CvarunE morsHA aw
FramingE rmorzF aw
ParityErmarsRaw
T=CPSInst
R=CPSInzt
T=CPSMinute
RxCPSMinute

o]

fi

Cancel |

|

Note: See the Port Monitor help system if you need an explanation of a

column.
8. Scroll to the right to view the new columns.
File Tools Wiew Help

=]

ST EIEEIER-TE

| RTS | DTR | Actual Throughput | TxTokal | Tokal Errars | CverrunErrars | FramingErrars | ParityErrors | CreerrunErrarsRaw | ParityErrorsR.aw

CFF  OFF ] 64923300 0 1] a 1] u] u]

OFF  OFF 0 a a a a o a % a

OFF _OFF 0 a a a a a a a

QFF  QOFF 1] o] 1] 1] o 1] u] u]

OFF OFF ] a 1] 1] a 1] u] u]

CFF  OFF ] a 1] 1] a 1] u] u]

CFF  OFF ] a 1] 1] a 1] u] u]

OFF  OFF 0 a a 1] a a a a
kil [
Ready Palling kimer is O MM A
9. Ifyou want to capture this session, you can save a current session as a report.

To do this, select one of the following save options:
¢ File > Save As

¢ File > Save - if the report already exists in an older format

e Save Active Session E button

Reports can be opened, viewed and re-used when needed. To open and view a

report:

a. Select File > Open or the Open Existing Session E button. The Open
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Using Test Terminal

Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.

Optionally, if you want to continue monitoring for an existing session, you
need to activate the Polling Interval.

¢ Select Tools > Settings to access the PMon2 Settings dialog
¢ Change the Polling Interval field to a value other than zero (0)

10. Leave Port Monitor open so that you can review events when using Test

Terminal to test a port or ports.

Opening Ports

Test Terminal (WCom2) allows you to open a port, send characters and commands
to the port, and toggle the control signals. This application can be used to
troubleshoot communications on a port-by-port basis.

Send and Receive Test Data: This sends data out the transmit line to the
loopback plug, which has the transmit and receive pins connected thus
sending the data back through the Rx line to Test Terminal, which then
displays the received data in the terminal window for that port. This test is
only testing the Tx and Rx signal lines and nothing else. This test works in
either RS-232 or RS-422 modes as both modes have transmit and receive
capability. A failure in this test will essentially prevent the port from working
in any manner.

Loopback Test: This tests all of the modem control signals such as RTS, DTR,
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is
made HI in one line the corresponding signal line indicates this. The Loopback
Test changes the state of the lines and looks for the corresponding state
change. If it successfully recognizes all of these changes, the port passes.

A failure on this test is not necessarily critical as it will depend on what is
connected and how many signal lines are in use. For example, if you are using
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure will cause no
discernible issue since the other signals are not being used. If the port is
configured for use as either RS-422 or RS-485 this test will fail and is expected
to fail since RS-422 and RS-485 do not have the modem control signals that
are present in RS-232 for which this test is designed.

The following procedures require a loopback plug to be placed on the port or ports
that you want to test. A loopback plug was shipped with your DeviceMaster. If you
need to build a replacement or additional loopback plugs, refer to the
DeviceMaster Installation and Configuration Guide (Page 7), if you need to build
loopback plugs.

The following procedure shows how to use Test Terminal to send and receive test
data to the serial ports. If necessary, install PortVision DX (Page 10).

1.

2.

Stop all applications that may be accessing the ports such as RRAS or any
faxing, or production software. See the appropriate help systems or manuals
for instructions on stopping these services or applications.

If another application is controlling the port, then Test Terminal will be unable
to open the port and an error message will be shown.

Open PortVision DX using the desktop shortcut.
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Sending and Receiving Test Data (RS-232/422 and RS-485: 4-Wire)

Sending and

Receiving Test Data
(RS-232/422 and RS-

485: 4-Wire)

3. Start Test Terminal (WCom2) by clicking Tools > Applications > Test Terminal

(WCom2).
TPV PortVision DX o e =)
File Manage View Help
- A Refresh Al ) — =
gy > — ) ﬁ -
b Scan Network ot - o 3
Scan  Refresh Al o bpage Notes Help  About Exit
. Check for Updates ...
Log file » b ES9S28[9/9]
Applications v Customize ...
IPORTVI
Options ... Test Terminal (WCom2) N
| Port Monitor (PMonz2)
HyperTerminal
Drivers L
Name : First Floor - E
B~ Es8510
..... B v ES3510-XTE
..... I+ 10-Link Master 1
B+ Modbus/TCP
i B+ PRO-17:FRFB
----- B RTS.2E- 2:FRFS
Use menu or toobar to add natesin = || B ' RTS4 - 07:FRFC
this area. =i
B SHS
B UPLS5-30VDC
i [ [==) Fourth Floor [28 / 29]
— (C=—= - n__u_ro ram g
o | [~ Device Name [ Model IP Address MAC Address | Software Version [ status
Bv 9528 ES9528 19216811105 00:C04E33:00:01 v1d4_betad (b110.3)  ON-LINE
I v I0-link Master #1 10-Link Master EIP-4  192.168.11.199 AE3%:FEFS  EtherNet/IP 0,83 ON-LINE
=|[® v Modbus/TCP UP-1P (5¥) 192.168.11.53 Medbus/TCP 5.07 ON-LINE
B« {& PRO - 1T:FRFB PRO-8P (DBY) 192.168.11.20 NS-Link 803 ON-LINE
B RTSE-OT:FRFC RTS-4P (DE) 19216811.23 00 NS-Link 811 ON-LINE
B RTS2E - 20:FRF5 RTS-2P (2E) 192168.11.52  00:COME29:FFFS SocketServer9.11 ON-LINE
Bv  sHB SH-8P (DB9) 192.168.11.14  00:C04E1CFRFD NS-Link 9.11 ON-LINE
B UPL:S5-30VDC UP-1P (5-30V) 1921681155  00:C04E21:05:CD Modbus Server 404 ON-LINE
‘ [ 3
First Reserved Application ID for the menu FirstFloor | |1 [Ready

Select File > Open Port, the
appropriate port (or ports)
from the Open Ports drop-

down list and Ok.

Note: Ifyou left Port Monitor
open from the previous
subsection, you should
show that the port is

open.

Go to the next procedure to send
and receive test data. Use the
appropriate procedure:

Sending and Receiving Test
Data (RS-232/422 and RS-

485: 4-Wire) on Page 80

Sending and Receiving Data
(RS-485: 2-Wire) on Page 82

Open Ports ... |

% Select Ports

COvz 2

Cancel

Settings

il

COom3
rokdin LI
" Select Range

For example: 3-15,21,45,51-56,74

You can use this procedure to send and receive test data through the RS-232/422/
485 (4-wire, full-duplex) port or ports that you want to test.

1.
2.

If you have not done so, perform Steps 1 through 3 on Page 79.

Install the loopback plug onto the port (or ports) that you want to test.

See the DeviceMaster Installation and Configuration Guide that you can
download on Page 7, if you need to build loopback plugs.

Select Port > Send and Receive Test Data.
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You should see the
alphabet scrolling [ wComz - Test Terminal 1ol x|
across the port. If so,
then the port installed
properly and is

File Port Settings  View ‘Window He

| & 3 (& | @ =T ¥

operational. 101
Note: If you left Port BCDEFGHIJKLMNOPQRSTUVW -]
Monitor BCDEFGHIJKLMNOPQRSTUWVWX
running, it BCDEFGHIJKLMNOPQRSTUYWXY
should show BCDEFGHLIKLMNOPQRSTUVWXYZ
data sent and B
received and BC
show the
BCD
average data
BCDE
throughput on BCDEE
the port
port. BCDEFG
4. Select Port > Send and BCDEFGH

I aTalateln'al N1}

Receive Test Data to stop
the scrolling data.

Ready l_ W i

5. You can go to the next
procedure to run the Loopback Test on Page 81 if this is an RS-232 port.

If this test successfully completed, then the port is operational as expected.

Note: Do NOT forget to restart the communications application.

Loopback Test (RS- The Loopback Test tests the modem control (hardware handshaking) signals. It

232) only has meaning in RS-232 mode on serial connector interfaces with full RS-232
signals. If performed under the following conditions, the test will always fail
because full modem control signals are not present:

e RS-422

e RS-485

¢ RJ11 connectors

Use the following steps to run the Loopback Test.

1. If necessary, start Test Terminal (Page 79, Steps 1 through 3).
2. Click Port > Loopback Test.

This is a pass fail test and will take a second or two to complete. Repeat for
each port that needs testing.

If the Loopback Test and the Send and Receive Test Data tests successfully
complete, then the port is operational as expected.
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Sending and This procedure shows how to use Test Terminal (WCom2) to test two RS-485 (2-
Receiving Data (RS- wire, half-duplex) ports.
485: 2-Wire) 1. Start Test Terminal.

2. Open two ports RS-485 ports. This example uses COM40 and COM41.

Fiod example: 3-15.21,4551-56.74

Test Terminal will open two windows, note that both ports show Receiving on
the status bar.

k3 WCom2 - Test Terminal

W COM40

3.

k2 WCom2 - Test Terminal

Fila Port Settings View Window Help
A
M COM40 FBEX = comst

Dizahle Sacadie.

RTS DTR RING Ready
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Both COM ports show Ready on the status bar.

k2 WCom?2 - Test Terminal
Fle Port Settings Yiew Window Help
B 2 & ¢ = F

. COMAO mEE T

4. Right-click in ONE window and select the Receive option from the pop up.
5. Right-click the OPPOSITE window and click Send.

E2 WCom? - Test Terminal EI@IEI
File Port Jettings View ‘Window Help
B & e ¢ o mo ¢

B COM40 CB)X) mcouds

ABCDEFGHIJKLM
ABCDEFGHIJKLMN
ABCDEFGHIJELMNO

ABCDEFGHIJKLMNOP
ABCDEFGHIJELMNOPQ
ABCDEFGHIJELMNOPQR
ABCDEFGHIJKLMNOPQRS
ABCDEFGHIJKLMNOPQRST
ABCDEFGHIJKLMNOPQRSTU
ABCDEFGHII

The Status line shows Sending or Receiving.

In this case, COM40 is sending data and COM41 is receiving the data which is
visually confirmed by the data scrolling across the COM41 window.

Note: If you do not see the data being received it MAY be necessary to also
disable the RTS and DTR options from the right-click pop-up menu in
each COM port.

6. Right-click and remove the check mark on the Sending COM port.
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7. Right-click and remove the check mark on the Receiving COM port.

|EX WComZ - Test Terminal

|- [B%| = coma1
ABCDEFGHIJKLMNOPQR

ABCDEFGHIJKLMNOPQRS
ABCDEFGHIJKLMNOPQRST

ABCDEFGHI IABCDEFGHIJKLMNOPQRSTU
ABCDEFGHL ABCDEFGHIJKLMNOPQRSTUY
ABCDEFGHIJK ABCDEFGHIJKLMNOPQRSTUVW
\ABCDEFGHIJKL ABCDEFGHIJKLMNOPQRSTUVWX
ABCDEFGHLJKLM IABCDEFGHIJELMNOPORSTUWVWXY
ABCDEFGHIJKLMN ABCDEFGHIJKELMNOPQRSTUVWAYZ

W

Receiving... 2~ WOPEN Sending. ..

Neither COM port is sending or receiving data but shows Ready on the Status
bar.

8. Reverse the sending/receiving windows one at a time. Set the Receive option
first, then in the opposite window, select the Send option.

The Status line shows Sending or Receiving in the reverse windows.

Data is now scrolling in the COM40 window. COM41 is static as it is not receiving
data but transmitting data.
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How Disable/Enable the Device Driver

How Disable/Enable the Device Driver

Use this procedure to disable or enable the driver for a specific DeviceMaster.
1. Right-click the DeviceMaster that you want to disable (or re-enable).
2. Click Disable (or Enable).

e Comtrol Drivers Management Conscle

DeviceMaster

y General | Advanced
-AgF DeviceMaster LT, 16 Port
2 . _)DeviceMaster RTS, 4 e Metwork Connection Mode
i Disabl
&= DeviceMaster Serial H SERE I}) ©)MACMode 00 CO4ED7FFFC -
-AgEms PRO - Rocketlinx Cor Uninstall

RocketPort Infinity/Exg

x Metwork Settings

@ IP Mode 192,168.11.23
B RocketPort EXPRESS, Properties [ Enable SSL Mode —
RocketPort/RocketMoaenT __E oot Device

[ server Certificate
Client Certificate:

Device Settings
Device Name:  DeviceMaster RTS, 4 Port

User-Friendly Device Name:  DeviceMaster RTS, 4 Port

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ~ (Default: 10)
Mumber of Devices to Load at Once: 20 (Default: 20)

Do NOT Load Firmware to Device

0
Verbose EventLog [] (Troubleshooting Only)

Comtrel Drivers Management Console version 2,11

Copyright (C) 2011-2013 Comtrol Corporation. [Save Configuration ] [Lnad Configuration ] [ OK ] [ Cancel ] Apply

Technical Support

If you need technical support, contact Comtrol using one of the following methods.

g,ggf:;g Corporate Headquarters
Downloads http://www.comtrol.com/Support
Web site http://www.comtrol.com
763.957.6000
Phone CST: 8AM-6PM (Monday through Friday,

excluding major US holidays)
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Appendix A. Configuring Non-Plug and
Play Devices

After installing the hardware and driver for Windows operating systems, you can
use this discussion to configure non-plug and play COM ports.

Installing Non-Plug and Play Devices

Use the following procedure to install non-plug and play devices.

1. If you have not so yet, connect the device to a DeviceMaster port and turn on
the device.

2. Open the Control Panel.

3. Go to the appropriate subsection to install non-plug and play modems or
printers:

e [nstalling Modems on Page 87
e Installing Printers on Page 88

Installing Modems Use the following procedure to install non-plug and play modems.

1. Ifyou have not done so yet, connect the modem (or modems) to the desired
DeviceMaster port (or ports) and turn on the modem (or modems).

Note: This may take a few minutes, depending upon your system and the
number of modems you are installing.

Open the Control Panel and click the Phone and Modem Options icon.
Click the Modems tab.

Click Add.

Click Don’t detect my modem. I will select it from a list and then click Next.

S

Click an appropriate modem model and then click Next.

Note: If you have a driver from the modem manufacturer, click Have Disk and
browse to the location of the driver. If your modem is not listed, go to the
modem manufacturer’s web site and download the appropriate driver.

7. Highlight the port or ports on to which you have connected modems.
8. Click Finish to complete the modem installation.

9. Configure modem properties as necessary. For assistance, use the Windows
help system.

To use this modem or modems with RRAS, you can refer to the Comtrol RRAS
Configuration Querview for Windows XP document.
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Appendix A. Configuring Non-Plug and Play Devices

Installing Printers Use the following procedure to install a non-plug and play printer.

Note: If you want to install a plug and play printer, connect the printer to the
appropriate serial port and the driver should automatically install. If it
does not automatically install, use the following procedure as a guide with
the printer manufacturers documentation.

Open the Control Panel and click the Printers and Faxes icon.
Click Next when this screen appears.
Click the Local printer attached to this computer item.

Click the COM port that corresponds to the port to which the printer is
connected.

5. Click the Manufacturer, Printer type, and then click Next.

Note: If you have a driver from the printer manufacturer, click Have Disk and
browse to the location of the driver. If your printer is not listed, go to the
printer manufacturer’s web site and download the appropriate driver.

L

Optionally, enter a printer name and then click Next.
Click Yes if you want to print a test page.
Click Finish to complete the installation.

© ©® 3o

Close the Printer and Faxes Control Panel.
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